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 This study developed a computer software with operation manual for analysis,  

design, and drawing  of  reinforced concrete slabs-beams structure. Visual  basic  for  

applications ( VBA)   on  AutoCAD and Microsoft Excel were used as platform for 

developing the program. The  reinforced concrete structures subjected various loading 

conditions can be designed according to the working stress design method 

recommended by the engineering institute of Thailand(EIT).This program will be 

shorten time and effort for structure design work since structural analysis, Reinforced 

conctete desing, and drawing are able to perform within this program. 
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Java       =           Javascript 
RB                           =                Steel Round bar 
RC       =           Reinforced  Concrete 
SD       =           Steel Deformed bar 
USD       =           Ultimate Strength Design method 
VBA       =           Visual  Basic  for  Applications 
WSD       =           Working Stress Design method 
2D       =           ระนาบ 2 มิต ิ
3D       =            ปริภูมิ  3 มิต ิ
2D-Frame      =           โครงข้อแข็ง 2 มิติ 
3D-Frame      =           โครงข้อแข็ง 3 มิติ 
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บทที่ 1 
บทน ำ 

 

1.1 ควำมเป็นมำและควำมส ำคัญของปัญหำ 
ปัจจุบันโปรแกรมคอมพิวเตอร์  เข้ามามีบทบาทส าคัญในการวิเคราะห์ ออกแบบและเขียน

แบบทางวิศวกรรมเป็นอย่างมาก  เน่ืองจากเป็นเคร่ืองมือที่สามารถท างานได้อย่างรวดเร็ว มีความถูก
ต้องแม่นย าสูง  แก้ไขและปรับปรุงข้อมูลได้โดยง่าย   จัดเก็บข้อมูลได้ในปริมาณที่มากและเป็น
ระบบ  จึงท าให้มีการพัฒนาโปรแกรมคอมพิวเตอร์เพื่อเพิ่มประสิทธิภาพในการท างานด้านการ
วิเคราะห์ออกแบบและการเขียนแบบโครงสร้างอย่างมากมาย   แต่โปรแกรมที่ถูกพัฒนาขึ้น
ส่วนมากจะมีการใช้งานที่แยกส่วนการท างานโดยสิ้นเชิง  กล่าวคืออาจจะต้องใช้โปรแกรมหนึ่ง
ส าหรับการวิเคราะห์โครงสร้างและใช้อีกโปรแกรมหนึ่งส าหรับการออกแบบโครงสร้าง  อีกทั้งการ
ป้อนข้อมูลน าเข้าเพื่อน าไปใช้ส าหรับการวิเคราะห์ส่วนใหญ่จะเป็นการป้อนข้อมูลแบบตัวเลข  ซึ่ง
ท าให้เกิดความไม่คล่องตัวในการใช้งาน   

จากปัญหาดังกล่าว ผู้ศึกษาจึงมีแนวคิดพัฒนาโปรแกรมคอมพิวเตอร์ส าหรับวิเคราะห์
ออกแบบและเขียนแบบโครงสร้างพื้น-คานคอนกรีตเสริมเหล็ก ด้วยชุดค าสั่ง Visual Basic for 
Applications  (VBA)  บน AutoCAD และ Microsoft Excel ให้มีส่วนโต้ตอบกับผู้ใช้งาน น าเข้า
ข้อมูลจากการเขียนแบบแปลนอาคาร ในรูปแบบของกราฟิกและตัวเลข  ค านวณวิเคราะห์
โครงสร้างคานด้วยวิธี  Moment Distribution ได้ทั้ งชั้น  (Floor Plan Level) ออกแบบพื้น -คาน
คอนกรีตเสริมเหล็ก  ตามมาตรฐานข้อก าหนดของวิศวกรรมสถานแห่งประเทศไทย ด้วยวิธีหน่วย
แรงใช้งาน (วสท.1007-34) ออกแบบพื้นสองทางโดยใช้วิธีที่ 2 (วสท.  9102) รับแรงตามแนวแกน 
(แรงดึงและแรงอัด)  แรงเฉือน  แรงดัดและโมเมนต์บิด สามารถเขียนแบบแปลนรูปตัดและแสดง
รายละเอียดทางโครงสร้างพื้น-คานคอนกรีตเสริมเหล็ก  แสดงผลได้ทั้งแบบกราฟิกและตัวเลขทาง
หน้าจอคอมพิวเตอร์และเคร่ืองพิมพ์ 
 

1.2 วัตถุประสงค์ 

1.2.1 เพื่อศึกษาและพัฒนาโปรแกรม ด้วยชุดค าสั่ง VBA  บน  AutoCAD  และ  Microsoft 
Excel  ให้สามารถวิเคราะห์ออกแบบและเขียนแบบโครงสร้างพื้น-คานคอนกรีต
เสริมเหล็ก ด้วยวิธีหน่วยแรงใช้งาน 

1.2.2  เพื่อน าโปรแกรมไปใช้ในการวิเคราะห์  ออกแบบและเขียนแบบโครงสร้างพื้น-คาน
คอนกรีตเสริมเหล็กและสามารถแสดงผลลัพธ์ได้ทางหน้าจอคอมพิวเตอร์และ
เคร่ืองพิมพ์ 
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1.2.3  จัดท าคู่มือการใช้งานโปรแกรม  
 
1.3  ขอบเขตของกำรศึกษำ 

1.3.1 ก าหนดตัวอย่างแบบก่อสร้างเพื่อใช้ในการศึกษา โดยใช้แบบมาตรฐานบ้านเพื่อ
ประชาชน พ.ศ.2559  ของกรมโยธาธิการและผังเมือง กระทรวงมหาดไทย จ านวน 2  
แบบ 

1.3.2 ท าการศึกษาและทดสอบการเขียนชุดค าสั่ง VBA เพื่อพัฒนาโปรแกรมใน VBA 
Editor บน  AutoCAD  และ  Microsoft Excel   

1.3.3 ทดสอบโปรแกรมจากชุดค าสั่ง VBA ที่ได้พัฒนาขึ้น ให้สามารถเชื่อมโยงข้อมูลกัน
ได้ระหว่าง AutoCAD  และ Microsoft Excel 

1.3.4 วิเคราะห์โครงสร้างคานด้วยวิธี  Moment Distribution   
1.3.5 ทดสอบโปรแกรมที่ได้พัฒนาขึ้นให้สามารถวิเคราะห์ ออกแบบและเขียนแบบ

โครงสร้างพื้น-คานคอนกรีตเสริมเหล็กได้ตามมาตรฐานข้อก าหนดของวิศวกรรม
สถ าน แห่ งป ระ เท ศไท ย  ด้ ว ยวิ ธี ห น่ วยแรงใช้ ง าน  (วส ท .1007-34) แล ะ
พระราชบัญญัติควบคุมอาคาร พ.ศ. 2522 

1.3.6 โปรแกรมสามารถแสดงผลการวิเคราะห์  ออกแบบและเขียนแบบโครงสร้างพื้น-คาน
คอนกรีตเสริมเหล็กได้ทางหน้าจอคอมพิวเตอร์และเคร่ืองพิมพ์  

 
1.4  ประโยชน์ท่ีคำดว่ำจะได้รับ 

1.4.1 สามารถใช้งานโปรแกรมที่พัฒนาขึ้น ส าหรับการวิเคราะห์  ออกแบบและเขียนแบบ
โครงสร้างพื้น-คานคอนกรีตเสริมเหล็กได้อย่างถูกต้อง  รวดเร็ว  มีประสิทธิภาพ 

1.4.2 สามารถแสดงผลลัพธ์แรง  แผนภาพแรงปฏิกิริยา  แผนภาพแรงเฉือน  แผนภาพ
โมเมนต์ดัด  พร้อมทั้งจัดท ารายการค านวณโครงสร้างพื้น-คานคอนกรีตเสริมเหล็ก
ได้  ทั้งทางหน้าจอคอมพิวเตอร์และเคร่ืองพิมพ์ 

1.4.3 คู่มือการใช้งานโปรแกรม 
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บทที ่2 
ทฤษฎีและงำนวิจัยที่เก่ียวข้อง 

 
การศึกษาและสืบค้นข้อมูลที่เกี่ยวข้องกับการพัฒนาโปรแกรมวิเคราะห์  ออกแบบและ

เขียนแบบโครงสร้างพื้น-คานคอนกรีตเสริมเหล็กในคร้ังนี้  ผู้ศึกษาได้รวบรวมเอกสารที่เกี่ยวข้อง
มาใช้ประกอบในการศึกษา  โดยได้ก าหนดประเด็นไว้ดังนี้ 

1.  งานวิจัยที่เกี่ยวข้อง 
2.  การวิเคราะห์โครงสร้างด้วยวิธี  Moment Distribution   
3.  ข้อก าหนดการออกแบบโครงสร้างคอนกรีตเสริมเหล็กด้วยวิธีหน่วยแรงใช้งาน  
4.  การเขียนแบบด้วยโปรแกรมคอมพิวเตอร์  
5.  การพัฒนาโปรแกรมด้วย VBA  
 

2.1  งำนวิจัยท่ีเกี่ยวข้อง 
ผลงานที่เกี่ยวข้องกับโปรแกรมคอมพิวเตอร์ส าหรับการวิเคราะห์และออกแบบพื้นคาน

คอนกรีตเสริมเหล็ก  มีดังนี ้
กฤษดา รักษากุลและคณะ ได้สร้างโปรแกรมคอมพิวเตอร์ชื่อ  Visual RC Design 

พัฒนาขึ้นมาเพื่อใช้ในการค านวณเพื่อออกแบบโครงสร้างอาคารคอนกรีตเสริมเหล็ก ท างานบน 
Microsoft Windows  มีการป้อนข้อมูลและแสดงผล ในลักษณะที่ เป็นกราฟิกอินเตอร์แอคทีฟ 
(Graphic User Interface) ด้วยการวาดภาพผังโครงสร้างลงบนหน้าต่างหลักของโปรแกรม ก าหนด
เส้นกริด  การวางต าแหน่งเสา  การวางต าแหน่งคาน  แผ่นพื้น การรับน้ าหนักของคาน  รับน้ าหนัก
บรรทุกตามแกนดิ่งชนิด Point Load  และ  Distributed Load  รับโมเมนต์ดัด  รับโมเมนต์บิด  เมื่อ
ป้อนข้อมูลเสร็จ  ท าการวิเคราะห์โครงสร้างที่มีลักษณะเป็น Composite Structure 2D-Frame มีการ
ออกแบบคานคอนกรีตเสริมเหล็กด้วย  ตลอดจนค านวณปริมาณเหล็กเสริมที่จ าเป็นส าหรับแผ่นพื้น 
ค.ส.ล.  คาน ค.ส.ล.และเสาค.ส.ล. มาตรฐานการออกแบบของวิศวกรรมสถานแห่งประเทศไทย 
(วสท. 2534)  และ Building code requirements for structural concrete  of  the American Concrete  
Institute (ACI Code)  โดยวิธีหน่วยแรงใช้งาน  (Working  Stress  Design  Method)  และวิธีก าลัง 
(Strength Method) ตามมาตรฐาน วสท.1007-34  และ  วสท. 1008-38  ตามล าดับ  หน่วยที่ใช้ใน
โปรแกรมเป็นหน่วยเมตริก  มีรูปตัดแสดงรายละเอียดการเสริมเหล็ก  ส่วนการแสดงผลลัพธ์จะ
แสดงผลทั้งทางหน้าจอคอมพิวเตอร์และทางเคร่ืองพิมพ์   สามารถเข้าเล่มเพื่อใช้เป็นรายการค านวณ
ประกอบแบบก่อสร้าง  เพื่อขออนุญาตปลูกสร้างอาคารกับทางราชการได้ 

https://www.google.co.th/url?sa=t&rct=j&q=&esrc=s&source=web&cd=1&cad=rja&uact=8&ved=0ahUKEwiE1YeRh53SAhWKP48KHffTCYYQFggbMAA&url=https%3A%2F%2Fth.wikipedia.org%2Fwiki%2FVisual_Basic_for_Applications&usg=AFQjCNGEQZR7FM4TPUSly_WcHEIMq-lxVg&bvm=bv.147448319,d.c2I
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มงคล จิรวัชรเดช [1] ได้พัฒนาเว็บไซต์เพื่อช่วยในการวิเคราะห์และออกแบบโครงสร้าง 
คอนกรีตเสริมเหล็กด้วยวิธีหน่วยแรงใช้งาน โดยอ้างอิงตามมาตรฐานของวิศวกรรมสถานแห่ง
ประเทศ ไทย(วสท. 1007-34 และ วสท. 1008-38) และ Building code requirements for structural 
concrete  of  the American Concrete  Institute ;ACI Code (ACI 318-95)  เพื่อพัฒนาการให้บริการ
ทางวิชาการและวิชาชีพผ่านเครือข่าย อินเตอร์เน็ต โดยใช้ภาษา HTML ( Hypertext Markup 
Language)   มีส่วนโต้ตอบกับผู้ใช้   โปรแกรมที่ใช้ในการวิเคราะห์และออกแบบรวมถึงการสร้าง
รายการค านวณจะใช้ภาษา   Javascript   เมื่อได้ผลจากการออกแบบแล้วจะใช้การเขียนโปรแกรม
ด้วยภาษา Java ในการแสดงภาพกราฟิกของแบบที่ได้   เว็บไซต์นี้สามารถใช้ในการออกแบบส่วน
อาคารพื้นฐาน  ได้แก่ พื้น  บันได  คาน  เสาและฐานราก  หน่วยที่ใช้ในโปรแกรมเป็นหน่วยเมตริก  
ส่วนการแสดงผลลัพธ์จะแสดงผลทั้งทางหน้าจอคอมพิวเตอร์และทางเคร่ืองพิมพ์ 

วิชา  สุธาสิส  ได้สร้างโปรแกรมคอมพิวเตอร์ชื่อ  Visstructure 4  ซึ่งเป็นโปรแกรมที่ใช้
ส าหรับการออกแบบโครงสร้างอาคารเสริมเหล็กท างานบน Microsoft Windows วิ เคราะห์
โครงสร้างแบบ 2D-Frame ส่วนหนึ่งของโปรแกรมได้มีการออกแบบคานคอนกรีตเสริมเหล็กด้วย  
พิจารณามาตรฐานการออกแบบของวิศวกรรมสถานแห่งประเทศไทย (วสท. 2534)  และ ACI Code  
โดยวิธีหน่วยแรงใช้งาน (Working Stress Design Method)  หน้าตัดคานที่ใช้ในการออกแบบคือ
หน้าตัดสี่เหลี่ยม  การรับน้ าหนักของคานรับน้ าหนักบรรทุกตามแกนดิ่ง  รับโมเมนต์ดัด  สามารถ
ออกแบบต้านแรงโน้มถ่วง  แรงลมและแผ่นดินไหว   รับโมเมนต์บิดและโมเมนต์กระท าที่ Node 
ได้  หน่วยที่ใช้ในโปรแกรมเป็นหน่วยเมตริก   มีรูปตัดแสดงรายละเอียดการเสริมเหล็ก  ส่วนการ
แสดงผลลัพธ์จะแสดงผลทั้งทางหน้าจอคอมพิวเตอร์และทางเคร่ืองพิมพ์  สามารถเข้าเล่มเพื่อใช้
เป็นรายการค านวณประกอบแบบก่อสร้าง   เพื่อขออนุญาตปลูกสร้างอาคารกับทางราชการได้ 

ศักดา  กตเวทวารักษ์ [2] ได้พัฒนาโปรแกรมการวิเคราะห์และออกแบบคานต่อเนื่อง
คอนกรีตเสริมเหล็ก  ซึ่งเป็นงานที่ซับซ้อนและยุ่งยากในการค านวณด้วยมือ  ดังนั้นงานวิจัยจึงมี
วัตถุประสงค์เพื่อสร้างเคร่ืองมือช่วยในการวิเคราะห์และออกแบบ  โดยใช้โปรแกรมประยุกต์ 
Visual Basic Application (VBA)  on  Microsoft Excel เพื่ อความสะดวกรวดเร็ว   ได้ผลลัพธ์ที่
ถูกต้องแม่นย า  โปรแกรมที่สร้างขึ้นมานี้มีขั้นตอนการวิเคราะห์คานต่อเน่ือง  ซึ่งกระท าโดยใช้วิธี
วิเคราะห์แบบเมตริก (Matrix Analysis Method)  และออกแบบคานต่อเนื่องคอนกรีตเสริมเหล็ก  
โดยใช้ วิธีหน่ วยแรงใช้ งาน  (Working Stress Method) และวิธีก าลั ง  (Strength Method) ตาม
มาตรฐาน วสท. 1007-34  และ  วสท. 1008-38  ของวิศวกรรมสถานแห่งประเทศไทยในพระบรม
ราชูปถัมภ์ตามล าดับ ซึ่งเมื่อท าการทดสอบโปรแกรมค านวณที่สร้างขึ้น  พบว่าสามารถน ามาใช้
วิเคราะห์และออกแบบได้อย่างถูกต้องและแม่นย า  การแสดงผลลัพธ์จะแสดงผลทั้งทางหน้า
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จอคอมพิวเตอร์และทางเคร่ืองพิมพ์ 
สรกานต์ ศรีตองอ่อน และ ขัยธร ชาติพฤกษพันธ์ [3] ได้พัฒนาแนวคิดการป้อนข้อมูลและ 

แสดงผลลัพธ์ ส าหรับโปรแกรมคอมพิวเตอร์เพื่อช่วยในการวิเคราะห์โครงข้อหมุนด้วยวิธีสติฟเนส 
โดยทั่วไปนั้นสามารถประมวลผลได้อย่างรวดเร็ว  แม่นย า  แต่ปัญหาคือความล่าช้าในการก าหนด 
ข้อมูลที่ใช้ในการวิเคราะห์   ความไม่สะดวกในการตรวจสอบข้อมูลเนื้ อที่หน้าตัดของแต่ละ
ชิ้นส่วนกรณีที่มีหลายหน้าตัด  ซึ่งหากข้อมูลผิดพลาดก็มีผลท าให้การวิเคราะห์ผิดพลาดตามไปด้วย
และความไม่สะดวกในการพิจารณาผลลัพธ์แรงภายในชิ้นส่วน  โดยเฉพาะการเลือกค่าสูงสุดเพื่อ
น าไปใช้ออกแบบ  งานวิจัยนี้ได้ท าการพัฒนาโปรแกรมคอมพิวเตอร์ชื่อ  “ซีซีทีทรัส รุ่น 1.70” เพื่อ
ท าการแก้ปัญหาดังกล่าวข้างต้น  โดยการป้อนข้อมูลใช้แนวคิดของวิซาร์ดในการก าหนดรูปทรง
มาตรฐานของโครงข้อหมุน  อีกทั้งสามารถแสดงกราฟิกโครงข้อหมุนให้แยกสีในการแสดง
ชิ้นส่วน  เมื่อมีเนื้อที่หน้าตัดต่างกัน  และในการแสดงผลลัพธ์ ให้แสดงกราฟฟิกแยกสีของแรงดึง
และแรงอัดและแสดงเส้นหนาในค่าสูงสุด  ร่วมกับการแสดงค่าสูงสุดของแรงภายใน  ซึ่งช่วยท าให้
การเลือกชิ้นส่วนในการออกแบบท าได้รวดเร็ว  หน่วยที่ใช้ในโปรแกรมเป็นหน่วยเมตริก  ส่วนการ
แสดงผลลัพธ์จะแสดงผลทั้งทางหน้าจอคอมพิวเตอร์และทางเคร่ืองพิมพ์   สามารถเข้าเล่มเพื่อใช้
เป็นรายการค านวณประกอบแบบก่อสร้าง  เพื่อขออนุญาตปลูกสร้างอาคารกับทางราชการได้ 
 
2.2 กำรวิเครำะห์โครงสร้ำงด้วยวิธี  Moment Distribution [6]    

วิธี moment distribution  เป็นวิธีการวิเคราะห์โครงสร้างอีกวิธีหนึ่งที่ใช้ในการวิ เคราะห์
คานและโครงข้อแข็งที่ เป็นโครงสร้าง statically determinate ได้เป็นอย่างดี  วิธีการนี้ เป็นการ
วิเคราะห์โครงสร้างโดยวิธี displacement method  เช่นเดียวกันกับวิธี slope-deflection ซึ่งได้ถูก
พัฒนาขึ้นมาโดย  Professor  Hardy  Cross ในปี 1932  วิธีการนี้มีลักษณะเป็นการแก้สมการหลาย
ชั้น (simultaneous equation)  ที่ได้จากการแทนสมการของ end moments  ลงในสมการความสมดุล 
ในวิธี slope-deflection แบบประมาณอย่างต่อเนื่อง (successive approximation) ซึ่งความถูกต้อง
แม่นย าของผลการวิเคราะห์ที่ได้จะขึ้นอยู่กับจ านวนคร้ังที่ใช้ในการวิเคราะห์ 

โดยทั่วไปแล้วการวิเคราะห์โครงสร้างโดยวิธี moment distribution  มีล าดับดังต่อไปนี้ 
1. สมมุติให้  joint ต่างๆ ของโครงสร้างถูกยึดแน่น (fixed) โดยที่ชิ้นส่วนต่างๆ ของ

โครงสร้างจะอยู่ในลักษณะของคานที่ถูกยึดแน่นที่ปลายทั้งสองด้าน (fixed-end beam) 
2. ท าการปลดปล่อย joint อันหนึ่งให้เป็นอิสระ  ซึ่งจะท าให้เกิด moment ต้านทานขึ้นที่

ปลายของทุกชิ้นส่วนของโครงสร้างที่เชื่อมต่อกับ joint ดังกล่าว (ซึ่งขนาดของ moment 
ที่เกิดขึ้นจะขึ้นอยู่กับความแกร่งต่อการดัด (flexural stiffness) ของแต่ละชิ้นส่วนของ
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โครงสร้าง) จากนั้น moment ต้านทานที่เกิดขึ้นจะถูกถ่ายทอดต่อไปที่ปลายด้านไกล
ของชิ้นส่วนของโครงสร้าง (ซึ่งขนาดของ moment ที่ถูกถ่ายทอดจะขึ้นอยู่กับ carryover 
factor ของแต่ละชิ้นส่วนของโครงสร้าง) 

3. ท าการยึด joint ในข้อที่ 2 แล้วท าการปลดปล่อย joint  ถัดไปอีก joint หนึ่ง ซึ่งจะท าให้
เกิด moment ต้านทาน  ขึ้นที่ปลายของทุกชิ้นส่วนของโครงสร้างที่เชื่อมต่อกับ joint 
ดังกล่าว จากนั้น  moment ต้านทานดังกล่าว  จะถูกถ่ายทอดไปยังปลายด้านไกลของ
ชิ้นส่วนของโครงสร้าง เหมือนกับที่ได้กล่าวไปแล้วในข้อที่ 2 

4. ท าการปลดปล่อยและยึด joint  ทีละ  joint  อย่างต่อเนื่องแล้ว  moments  ต้านทาน
เหล่านั้นก็จะถูกกระจาย (distributed) กลับไปกลับมา จนกระทั่งอยู่ในสมดุลและ joint 
ต่างๆ ของโครงสร้างก็จะเกิดการหมุนไปยังต าแหน่งสุดท้ายที่เราต้องการหา 
 

2.3 กำรออกแบบโครงสร้ำงคอนกรีตเสริมเหล็ก ด้วยวิธีหน่วยแรงใช้งำน  
ประเทศไทยมีข้อก าหนดการออกแบบโครงสร้างอาคารคอนกรีตเสริมเหล็ก 2 ฉบับ คือ 
1. พระราชบัญญัติควบคุมอาคาร พ.ศ. 2522  และที่แก้ไขเพิ่มเติม  มีกฎกระทรวงฉบับที่ 6 

(พ.ศ. 2527) , กฎกระทรวง ฉบับที่ 49 (พ.ศ. 2540) ในภาคผนวก ง  และข้อก าหนดใน
แต่ละท้องที่เช่น ข้อบัญญัติกรุงเทพมหานคร หรือเทศบัญญัติ 

2. วิศวกรรมสถานแห่งประเทศไทย  (วสท.) โดยข้อก าหนดที่เกี่ยวข้องกับคอนกรีตเสริม
เหล็กจะมีสองฉบับคือ มาตรฐานส าหรับอาคารคอนกรีตเสริมเหล็กโดยวิธีหน่วยแรง
ใช้งาน(วสท.  1007-34)  และมาตรฐานส าหรับอาคารคอนกรีตเสริม 

โดยข้อก าหนดที่ใช้ทั้งสองฉบับ  ได้น ามาจากส่วนที่เกี่ยวข้องกับการออกแบบและก่อสร้าง
อ าค าร โค ร งส ร้ า ง ค อน ก รีต  Building  Code  Requirements  for  Structural  Concrete  and 
Commentary ของ American  Concrete Institute (ACI)       

การออกแบบโครงสร้างคอนกรีตเสริมเหล็ก โดยทฤษฎีหน่วยแรงใช้งาน (WSD) เป็นการ
ออกแบบหน่วยแรงที่ก าหนดใช้บรรทุกบนโครงสร้างนั้น ได้แก่ น้ าหนักบรรทุกคงที่ (น้ าหนักของ
ตัวโครงสร้างเอง)  น้ าหนักบรรทุกจร ได้แก่  ผู้อยู่อาศัย  สิ่งของที่สามารถเคลื่อนย้ายได้  ซึ่งจะถูก
สมมุติให้เกิดขึ้น  เมื่อโครงสร้างถูกใช้งานต้องไม่เกินกว่าหน่วยแรงใช้งานที่ยอมให้ (Allowable 
Working) โดยที่คุณสมบัติทางกลศาสตร์ของส่วนโครงสร้างเป็นแบบอีลาสติก ซึ่งจะเป็นค่าที่อยู่
ในช่วงของกราฟที่ยังเป็นเส้นตรง   กล่าวคือเป็นช่วงที่วัสดุยังมีความยืดหยุ่นและมีอัตราส่วนหน่วย
แรงการยืดหดตัวที่เป็นปฏิภาคกันวิธีหน่วยแรงใช้งาน  แสดงได้ดังนี ้
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                                            f ≤ [หน่วยแรงที่ยอมให้  fallow ]                                                  

 
 
 

เมื่อ   f           =   หน่วยแรงอีลาสติกที่ค านวณได้เช่นจากสูตรการตัด   f = Mc/I    ส าหรับคาน 
fallow   =   หน่วยแรงที่จ ากัดโดยมาตรฐานอาคารเป็นเปอร์เซ็นต์ของก าลังรับแรงอัด fc′       

ส าหรับคอนกรีตหรือ ของหน่วยแรงจุดคราก  fy ส าหรับเหล็กเสริม 
 

2.4   กำรเขียนแบบด้วยโปรแกรมคอมพิวเตอร์             
CAD  ย่อมาจาก Computer - Aided Design หรือ Computer - Aided Drafting ซึ่ง CAD ก็

คือ การใช้คอมพิวเตอร์ช่วยในการออกแบบเขียนแบบ โดยใช้ซอฟต์แวร์ที่เกี่ยวข้องกับงาน CAD 
เช่น AutoCAD ซึ่งท าให้สามารถสร้างงานที่มีประสิทธิภาพ  CAD เป็นเคร่ืองมือที่ ใช้ทั้งงาน
ออกแบบและเขียนแบบ  ท าให้การออกแบบที่เต็มไปด้วยขั้นตอนที่ซับซ้อนลดลง น าไปสู่ผลส าเร็จ
ของชิ้นงานทั้งแบบ 2 มิติ (2D) และ 3 มิติ (3D) และนอกจากการใช้งานดังกล่าวแล้วยังสามารถ
น าไปใช้ในโรงงานอุตสาหกรรม เช่น โรงงานผลิตชิ้นส่วนอาคารส าเร็จรูป (PreCast)  เป็นต้น  การ
แสดงผลชิ้นงานที่มาจาก CAD สามารถแสดงผลได้ทางหน้าจอคอมพิวเตอร์และเคร่ืองพิมพ์ 
(Printer , Plotter)  ดังรูปที่ 2.1 

 

 
รูปที่  2.1  แบบแปลนที่เขียนด้วย CAD 
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             2.4.1 ประโยชน์ของ CAD 
                        CAD ในประเทศไทยเป็นซอฟต์แวร์ที่นิยมใช้งานทางด้านวิศวกรรมกันอย่าง
แพร่หลายอย่างยาวนาน คือ โปรแกรม AutoCAD และได้รับความนิยมสอดคล้องกันทั่วโลก  จึงถือ
ได้ว่าโปรแกรมนี้เป็นเคร่ืองมือส าหรับงานออกแบบและเขียนแบบที่มีความเป็นสากล  ประโยชน์ที่
เห็นได้ชดัจากการใช้งาน AutoCAD มี 3 ประการ คือ 
         1.  สามารถใช้ท างานที่ซับช้อน โดยหากพิจารณาภาพรวมของการใช้งาน

คอมพิวเตอร์ในการปฏิบัติงาน จะเห็นได้ชัดว่าช่วยลดการท างานที่มีความ
ซับซ้อนได้อย่างมาก เช่นเดียวกับการเขียนแบบด้วย AutoCAD ซึ่งช่วยลดการ
เขียนแบบที่มีความซับซ้อนได้  เช่น การเขียนแบบของเฟอร์นิเจอร์ในส านักงาน  
ก็สามารถเขียนแบบเพียงชิ้นเดียว  แล้วสามารถคัดลอกไปใช้ได้หลายๆ คร้ัง  จึง
ไม่ก่อให้เกิดการท างานที่ซับซ้อน 

 2.  ความถูกต้องเมื่อมีการเขียนแบบโดยใช้ AutoCAD ส่วนประกอบต่างๆ ของภาพ
ที่ประกอบกันขึ้น ไม่ว่าจะเป็นเส้นโค้ง  เส้นตรงหรือวงกลม  จะถูกเก็บไว้เป็น
ไฟล์ เขียนแบบที่ใช้ เก็บข้อมูลเป็นตัวเลข  ความละเอียดของข้อมูลจึงสูง 
ตัวอย่างเช่น ความยาว 1 หน่วย หากใช้การก าหนดความยาวดังกล่าวด้วย 
AutoCAD จะสามารถให้รายละเอียดในส่วนย่อยได้  โดยอาจละเอียดได้ถึง 
1.000000000  หรือมากกว่านี้    จึงมีความแม่นย าและถูกต้องสูงสุด 100  
เปอร์เซ็นต ์

 3.  การใช้งานไฟล์ AutoCAD ร่วมกับซอฟต์แวร์อ่ืนในระบบโรงงานอุตสาหกรรม 
จะมีการเขียนซอฟต์แวร์คอมพิวเตอร์เพื่อเพิ่มประสิทธิภาพให้กับการท างาน 
โดยจะสามารถเชื่อมต่อกับระบบควบคุมอ่ืน  เพื่อให้สามารถแลกเปลี่ยนข้อมูล
ร่วมกันได้   ซึ่งเช่นเดียวกับการเขียนแบบด้วย CAD  ตัวอย่างเช่น การส่งข้อมูล
จากโปรแกรม Word  ซึ่งรูปแบบของข้อมูลเป็น Text ไปสู่ไฟล์ CAD  เพื่อใช้
งานร่วมกันได้ เป็นต้น 

2.4.2   แบบ  2 มิติ 
                       การเขียนแบบภาพ  2 มิติ  จะอาศัยการมองภาพในแนวสามแกนหลักตามที่ได้แสดง
ไว้ใน รูปที่ 2.2  โดยแกน x- y เป็นระนาบในแนวราบและแกน Z เป็นระนาบในแนวด่ิง โดยมุมมอง
ด้านหน้าจะมองตามระนาบในแกน y มุมมองด้านบนจะมองตามระนาบในแกน Z และมุมมอง
ด้านข้างจะมองตามระนาบในแกน  x  ถึงแม้ว่าภาพที่ได้จะมองดูมีมิติ  แต่ก็ยังถือว่าเป็นภาพ 2D อยู่  
เพราะว่าไม่สามารถแสดงมุมมอง 360 องศา  ได้ภายในงานชิ้นเดียว 
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รูปที่ 2.2  แนวแกนหลักที่ใช้อ้างอิงในการเขียนแบบ 2 มิติ 
  
 ภาพแบบ Plan หรือภาพแปลน คือ ที่แสดงความเป็น 2D ได้อย่างชัดเจนมากที่สุด 
เนื่องจากสามารถแสดงให้เห็นรายละเอียดได้เพียงหนึ่งระนาบเท่านั้น จึงเหมาะกับงานที่มี
รายละเอียดของภาพในระนาบ x – y 
 

 
 

รูปที่ 2.3   แบบแปลนโครงสร้างอาคาร (เสา , คาน , พื้น) 



10 
 

2.4.3 ส่วนประกอบต่าง ๆ ของ User Interface  ของ AutoCAD   
          โดยทั่วไปในทุกรุ่นมีหน้าจอ ดังต่อไปนี้  

1.  Graphic Area : คือส่วนที่ใช้แสดงผลงานที่ออกแบบเส้นตรง   วงกลม   ซึ่งเทียบ
ได้กับกระดาษที่ใช้ในการออกแบบ ซึ่งเป็นพื้นที่ส่วนใหญ่บนจอภาพ โดยที่ทุก
ต าแหน่งของ Graphic Area จะมี Cross Hair ที่ท าหน้าที่เป็นเหมือนกับ Cursor 

2.  Cross Hair : ท าหน้าที่คล้ายกับ Cursor   จะใช้แสดงต าแหน่งบน  Graphic  Area 
เคลื่อนที่ไปตามการเลื่อนของ Mouse เปรียบเทียบได้กับปากกาที่ใช้ในการเขียน
แบบตามค าสั่ง 

3.  Command Line : คือ บรรทัดค าสั่ง   ซึ่งจะอยู่บริเวณด้านล่างของจอภาพเป็นตัว 
อักษร 3 บรรทัด มีความส าคัญอย่างยิ่งต่อการใช้งาน AutoCAD  ซึ่งจะมีค าสั่งใน
การใช้งานที่ต้องอาศัยการโต้ตอบกับค าสั่งผ่าน Command Line 

4.  Coordinate Display  : ใช้แสดงต าแหน่งของ  Cross Hair  ซึ่งค่าที่ได้จะแสดง
ตามระยะจากแกน  x, y, z  เรียงตามล าดับ หากเป็นการใช้งาน 2 มิติ ค่าตัว
สุดท้ายจะเป็น 0.000 

5.  Status Bar : ใช้แสดงสถานภาพของค าสั่ง ที่จะช่วยในการเขียนแบบ  เช่น  
GRID, ORTHO  เป็นต้น   โดยสามารถคลิก เลือกที่ ปุ่ ม เพื่ อ เปลี่ ยนแปลง
สถานภาพได้ 

6.  Model and Layout Tab  :  เป็นส่วนที่ ใช้ ในการเปลี่ ยนสถานะการท างาน
ระหว่าง Model กับ Layout  โดยอยู่ที่ส่วนล่างของจอภาพเหนือ Command Line 
ซึ่งจะใช้  Model Tab ในการออกแบบชิ้นงาน  และ  Layout Tab ใช้ในการ
จัดรูปแบบของการเสนอภาพชิ้นงานที่ออกแบบให้เหมาะสมกับกระดาษพิมพ์
แบบ 

7.  Standard Toolbar :  เป็นชุดมาตรฐานทั่วไปที่ใช้จัดการเกี่ยวกับไฟล์  เช่น  New, 
Open, Save 

 8. Object Properties Toolbar  :  ใช้ในการแสดงคุณสมบัติต่าง ๆ ของชิ้นงาน  ว่าอยู่
ในเลเยอร์ใด  ลักษณะของเส้นเป็นอย่างไร  ท าให้ทราบลักษณะของชิ้นงานที่
ก าลังสร้างอย่างละเอียด 

9.  Draw and Modify Toolbar  :  เป็น Toolbar   ที่ใช้ในการสร้างภาพ   แก้ไขและ
ตั้งค่าที่ใช้ส าหรับสร้างภาพ 

10.  Menu Bar  : เป็นที่รวมของกลุ่มค าสั่งหลัก 
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รูปที่ 2.4  ส่วนประกอบต่าง ๆ ของ User Interface  ของ AutoCAD   
 

2.4.4  การก าหนดต าแหน่ง กระท าด้วยเมาส์ (Mouse)  
นับว่ามีความส าคัญเป็นอย่างยิ่งในการใช้งาน AutoCAD เพื่อเข้าสู่ค าสั่งก าหนด

ต าแหน่ง ฯลฯ ซึ่งจะมีหลักการในการใช้เมาส์ใน AutoCAD  ดังนี ้
ปุ่มซ้าย : ใช้ในการคลิกเลือกค าสั่ง และคลิกเพื่อเลือกต าแหน่งของหน้าจอภาพ 
ปุ่มขวา : สามารถใช้ในระหว่างที่ใช้ค าสั่งหนึ่งค าสั่งใดเหมือนกับการกดปุ่ม<Enter> 

เพื่อยอมรับค่าหรือเป็นการเข้าสู่ Shortcut Menu 
ปุ่มกลาง : ใช้เหมือนกับค าสั่ง Pan เพื่อเลื่อนรูปภาพไปยังต าแหน่งที่ต้องการ หรือให้

ล้อหมุนแสดงบนหน้าจอภาพ และย่อขยายภาพอีกด้วย 
การอ้างอิงพิกัดใน  AutoCAD การเคลื่อนที่ของเคอร์เซอร์ในโปรแแกรมโดยทั่วไป 

จะเป็นต าแหน่งตามการเคลื่อนที่ของเมาส์หรือการเคลื่อนที่ตามการพิมพ์จากแป้นพิมพ์ โดยใน 
AutoCAD จะเป็นการเคลื่อนที่ ของ Cross Hair บน Graphic Area ซึ่ งสามารถเคลื่อนที่ ไปยัง
ต าแหน่งที่ต้องการด้วยการคลิกเมาส์และการพิมพ์ต าแหน่ง   

1 

2 

3 

4 5 

6 

7 
8 

9 

10 
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รูปที่  2.5  การอ้างอิงพิกัดโดยใช้ต าแหน่งใน  2 มิติ 
 

การอ้างอิงพิกัดโดยใช้มุมในงาน 2 มิติ  สามารถก าหนดต าแหน่งได้โดยการระบุ
ระยะและมุมของต าแหน่งที่ต้องการตามที่ก าหนดโดยมีแกนที่ใช้ในการอ้างอิงดังรูปที่ 2.6 

 
 

 
 
 
 

 

รูปที่  2.6   การอ้างอิงพิกัดโดยใช้มุมในงาน  2 มิติ 
 

โดยการอ้างอิงด้วยวิธีนี้จะใช้เคร่ืองหมาย “<” ในการบอกขนาดของมุม ซึ่งการบอก
ขนาด จะเร่ิมจากการระบุระยะแล้วตามด้วยมุม ตัวอย่างเช่น @7<-45 หรือ @-5<90 เป็นต้น โดยการ
ก าหนดทิศทางการหมุนจะสามารถก าหนดตามเข็มนาฬิกาและทวนเข็มนาฬิกา ซึ่งจะก าหนด 
ทิศทางดังกล่าวได้ด้วยการก าหนดค่าเป็นบวก (+) และลบ (-) 

การก าหนดพิกัดโดยตรง  คือ การก าหนดค่าในแนวแกน x, y ในงาน 2D และ x, y, z 
ใน งาน 3D โดยการใช้ Cross Hair เคลื่อนไปยังต าแหน่งที่ต้องการด้วยเมาส์แล้วคลิก 

2.4.5 การเรียกค าสั่งใช้งาน AutoCAD นั้น มีด้วยกัน 6 วิธี คือ 
           1. Toolbar คือ ส่วนการใช้ค าสั่งที่ใช้เมาส์คลิกไอคอนเพื่อเข้าสู่ค าสั่ งซึ่งเมื่อมีการ

ใช้งานบ่อยคร้ังก็จะเกิดความช านาญและจ าได้ไม่ยากนัก โดยเหมาะกับค าสั่ง
การเขียนแบบที่ไม่ซับซ้อนมากนัก เช่น ค าสั่ง Copy, Line เป็นต้น 
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รูปที่ 2.7  การใช้งาน  Toolbar   
 

 2.  Screen Menu คือ เมนูที่จะปรากฏขึ้นต่อเมื่อมีการคลิกขวาที่เมาส์เท่านั้น 
 

 
 

 รูปที่ 2.8   การเรียกใช้งาน  Screen Menu 
 

 3.  Pull - Down Menu คือ การเข้าสู่ค าสั่งโดยการใช้ Menu Bar ซึ่งจะมีตั้งแต่เมนู
หลัก  แยกเป็นหมวดหมู่ และมีเมนูย่อยแยกออกไปอีก  เหมาะในการเข้าไป
ก าหนดค่าต่าง ๆ 
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รูปที่ 2.9  การเรียกใช้งาน  Pull - Down Menu 
 

 4. คีย์บอร์ด คือ การใช้งานค าสั่งผ่านทางคีย์บอร์ด โดยมีการใช้งานร่วมกันเพื่อเข้า
สู่ค าสั่ง  เช่น <Ctrl> พร้อมกับ <Z> หรือ  <Ctrl+Z> เพื่อใช้งานค าสั่ง Undo เป็น
ต้น และใช้งานในการพิมพ์ผ่านทาง Command Line  อีกด้วย 

 5.  Tablet Menu คือ การเข้าสู่ค าสั่งโดยตารางค าสั่งบน Digitizing ด้วยการเลือก
ค าสั่งตามสัญลักษณ์ที่ปรากฎในตารางค าสั่ง  แต่ไม่เป็นที่นิยมใช้งานมากมัก  
เพราะต้องซื้ออุปกรณ์เสริมในการใช้งานค าสั่งนี้  ซึ่งอันที่จริงแล้วการเข้าสู่ค าสั่ง
ในวิธีการข้างต้นดังที่กล่าวมาแล้วสามารถ ตอบสนองความต้องการได้อย่าง
ครบถ้วนแล้ว 

 6.  Command Line  คือ บรรทัดค าสั่ง  ซึ่งจะอยู่บริเวณด้านล่างของจอภาพ การใช้
งานที่ต้องอาศัยการโต้ตอบกับค าสั่ง 

 
 

 
รูปที่  2.10   Command Line   

 

2.5  กำรพัฒนำโปรแกรมด้วย VBA  
AutoCAD  เป็นโปรแกรมที่พัฒนามาจากภาษา AutoLISP  เป็นโปรแกรมที่เปิดกว้างให้กับ

ผู้พัฒนาโปรแกรมให้สามารถใช้หลาย ๆ ภาษาในการพัฒนาได้ เช่น LISP, C, VBA  

https://www.google.co.th/url?sa=t&rct=j&q=&esrc=s&source=web&cd=1&cad=rja&uact=8&ved=0ahUKEwiE1YeRh53SAhWKP48KHffTCYYQFggbMAA&url=https%3A%2F%2Fth.wikipedia.org%2Fwiki%2FVisual_Basic_for_Applications&usg=AFQjCNGEQZR7FM4TPUSly_WcHEIMq-lxVg&bvm=bv.147448319,d.c2I
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รูปที่  2.11   รูปแบบภาษาที่ใช้ในการพัฒนาโปรแกรมบน AutoCAD 
 

ส าหรับ VBA ถือว่าเป็นภาษาที่เหมาะสมส าหรับผู้เร่ิมต้น เพราะสามารถสร้าง Application 
ได้โดยไม่ยากนัก สามารถน ามาใช้สร้างโปรแกรมประยุกต์ในการท างานวิเคราะห์ออกแบบและ
เขียนแบบโครงสร้างคอนกรีตเสริมเหล็กได้ 

2.5.1 การเขียนชุดค าสั่ง VBA บน AutoCAD 
                      ผู้ท าการศึกษาพัฒนาโปรแกรมมีความรู้เกี่ยวกับภาษา Visual Basic เป็นพื้นฐานอยู่
แล้วจะยิ่งท าให้เข้าใจได้ง่ายในการเขียนชุดค าสั่ง VBA การเร่ิมต้นการเขียนชุดค าสั่ง VBA ท าได้
โดยการเปิดโปรแกรม AutoCAD จากนั้นก็เข้าสู่เมนู Tools >Macro>Visual Basic Editor   ดังรูปที่ 
2.11 หรือกดคีย์ลัด   <Alt>  +  <F11>  ก็จะพบ VBA Editor  ดังรูปที่ 2.12 
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รูปที่  2.12   ขั้นตอนการเข้าสู่ Visual Basic Editor  
 

 
 

รูปที่  2.13  Visual Basic Editor  
 

 หน้าต่าง Visual Basic Editor จะประกอบด้วยตัว Tool ต่าง ๆ ทางซ้ายมือก็จะมี List 
ของ Project ให้ถือว่า Dawing ที่ได้จากการ New file เปิด AutoCAD เป็นส่วนหนึ่งโปรเจคด้วย 
ส่วนด้านล่างจะเป็น Properties module คือสิ่งแรกที่สามารถสร้าง Application ได้ เมื่อคลิกขวาจะมี
การ Insert  UserForm, Module, Class module เมื่อด าเนินการเขียนชุดค าสั่ง VBA แล้วเสร็จ จากนั้น
ก็ท าการรันเพื่อทดสอบโปรแกรม ท าได้โดยกด  F5  ดังรูปที่ รูปที่  2.14  
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รูปที่  2.14   การเขียนชุดค าสั่ง VBA และการทดสอบโปรแกรม  
 

2.5.1.1  ความรูพ้ื้นฐานของค าสั่ง  VBA บน AutoCAD 
ค าสั่งพื้นฐานและรูปแบบของค าสั่งในด้านของการสร้าง Class การสร้าง 

Function และค าสั่งอื่นๆ ที่เป็นพื้นฐานส าคัญในการสร้าง Application มีดังต่อไปนี้ 
1.  การสร้าง Module โมดูลมีลักษณะเป็น global โปรแกรม AutoCAD จะ

บังคับในลักษณะที่เป็น module ที่อยู่ภายใต้ drawing ถ้าต้องการให้เป็น 
global กดปุ่มค าสั่ง Vbmanager  กดปุ่มค าสั่ง extract ตั้งชื่อ project 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่  2.15  Global  Module  ของ VBA บน  AutoCAD 
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 2.   การสร้าง  Function ฟังก์ชันมีประโยชน์คือสามารถแบ่งงานออกเป็น
โปรแกรมส่วนย่อยที่มีการ  return  ค่าได้ผ่านฟังก์ชันนั้น ๆ ส่วน 
subroutine จะเป็น process การท างานที่  return  ค่าไม่ได้  หากต้องการ
ให้ return ค่าได้  ต้องด าเนินการผ่าน global variable   

 
 
 
 
 
 
รูปที่  2.10   รูป  Global  Module  ของ VBA บนโปรแกรม AutoCAD 

รูปที่  2.10   รูปแสดงการสร้าง  Function  ของ  VBA  
 
 
 

3.  การสร้าง  Function  แบบ Call by reference/Value  การสร้างฟังก์ชันนี้
ท าหน้าที่ก าหนดค่าในการท างานของ subroutine  หรือฟังก์ชันให้
สามารถ return ในลักษณะที่กลับมาเป็น reference ได้  และท าการ
เปรียบเทียบค่ากับ Call By Value 

 
 
 
 
 
 
 
 
 
 

 

Sub Hello() 

   Dim var1 

   Dim var2, Var3 

   Dim ret 

 var1 = 20 

 var2 = 40 

 var3 = var1+var2 

 ret = MsgBox(factorial(5),vbOkOnly) 

End Sub 

 

Function factorial(n as Integer) As Integer 

   Dim i 

   Do While n>=1 

           i = i*n 

 n = n -1 

   Loop 

 factorial=i 

End Function 

 

Sub Test() 

   Dim v1 As Integer 

   Dim v2 As Integer 

   Dim ret 

 v1 = 10 

 v2 = 20 

   Call swap(v1,v2) 

   ret = MsgBox(v1,VbOkOnly) 

End Sub 

 

Sub swap(ByRef a As Integer,ByRef b As Integer) 

   Dim c 

   c=b 

   b=a 

   a=c 

End Sub 
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4.  การสร้าง Class คลาสท าหน้าที่ เปรียบเสมือนระบบ database ที่ใช้ใน
รูปแบบหน่วยความจ าหรือไฟล์ก็ได้  เปรียบเทียบได้กับบ้านพักอาศัยที่
มี component เช่น โต๊ะ เก้าอ้ี ที่ดิน ต้นไม้  ซึ่งใช้รูปแบบ  Class   กัน
บ่อยในระบบจัด เก็บข้อมูล  ฟั งก์ชันใน Class จะถูก เรียกใช้ เมื่ อ  
component ที่ assign ชื่อฟังก์ชัน และปิดท้ายด้วย  End  Function  

5.   ค าสั่ง  Set   เซทเป็นค าสั่งที่ใช้ในการอ้างอิงโดยที่ตัวแปรที่ตัวหนึ่งจะ
ไม่มีเนื้อในอยู่จ าเป็นต้องอาศัยอ้างอิงเน้ือในจากตัวแปรตัวอ่ืน ซึ่งค าสั่ง 
Set นี้มีประโยชน์ในการ Transfer ระหว่าง Object 

 
 
 
 
 

 
 

 
 

6.   การสร้าง Form  ฟอร์มเป็นค าสั่งหลักในการสร้าง  Dialog Box   ซึ่ง
ประกอบด้วย Control ต่าง ๆ เช่น Listbox CheckBox Frame รวมทั้ง
การใช้งาน Active X 

 

 
 

รูปที่  2.16   การสร้าง  Form  ของ VBA 

sub testform1() 

   Dim adlg As New form1 

   Dim str As String 

   Dim adlg2 As Form1 

   Set adlg2 = adlg 

           adlg.name1 = "hello" 

   adlg.Engble = True 

 adlg2.name1 = "Hi" 

 adlg.Show 

 Str=adlg.name1 

   ThisDrawing.Utility.Prompt(str) 

end sub 
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7.   User Interface มีหน้าที่ รับ  information จากผู้ใช้งานมาด าเนินการมี
องค์ประกอบส าคัญที่เรียกว่า toolbox การสร้าง create  เช่น การ access 
แบบพื้นฐาน ท าโดยการเรียกไปที่ module แล้วใช้ตัว variable ที่สร้าง
ไว้ตั้งแต่ตอนแรก .(dot) ตามด้วยชื่อ object ที่เราต้องการได้  

8.   Dialog Box เป็ น ส่ วน ห นี่ งที่ เรี ย ก ว่ า  form ใน  visual basic ส่ วน 
ประกอบที่ส าคัญของ form คือชื่อของ formcaption  คือชื่อที่อยู่บน title 
bar  การเรียกตัว form  ของ VBA ใน AutoCAD  ต้องสร้าง module  
ขึ้นมาโดยเรียกเปรียบเสมือน variable แล้วจึงใช้ค าสั่ง adlg.show ก็คือ 
ตัว variable.show  

 

 
 

รูปที่  2.17   Dialog Box  ของ VBA 
 

9.  Listbox ลิสบ๊อกเป็นเคร่ืองมือพื้นฐานท าหน้าที่เก็บข้อมูลใน list  มีอยู่ 2 
รูปแบบ  คือ การเขียนโปรแกรม access ให้ dialog แสดงผลและได้ 
output ออกมาแล้วน าไป  process ส่ วน อีกกระบวนการก็คือการ  
process ภายใน dialog  เอง  

10. Frame & Option Button(radioButton)  เฟรมท าหน้ าที่ จัดให้  Option 
Button เช็คอยู่ในกลุ่มเดียวกัน  ถ้าหากไม่ใส่ Option Button ใน frame ก็
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จะถือว่าเช็ครวมกันทั้ง form และในกรณีที่ใช้ frame ก็จะสามารถเพิ่ม 
OptionButton ได้อีกหลายกลุ่มด้วยการใช้ OptionButton สามารถ get 
เป็น state ได้ว่า true หรือ false  

11.  CheckBox เช็คบ๊อกท าหน้าที่ เป็น parameter ที่ เหมือนกับเป็น status 
ตัวอย่างการก าหนด property ของ checkbox Name = Enable Caption = 
Enable  

 

 
 

รูปที่  2.18   CheckBox ของ VBA 
 

12.  Active X ช่ วยท าให้ เขี ยน โปรแกรมได้ ง่ ายขึ้ น  มี ลั กษณ ะ เป็ น 
component เสริมในรูปแบบของ form เช่น tool  ที่เรียกว่า web browser  
ประโยชน์ของมัน  เช่น  ต้องการเขียน help หรือ information ของ 
product เกี่ยวกับการใช้งาน  เราอาจจะบอกเป็น URL ของ web site ไว้  
เวลา update ก็จะ update ได้ทันที  

 

 
 
 
 
 
 

 
 

Private Sub Go_Click() 

Dim addr As String 

addr = Me.TextBox1.Text 

Me.WebBrowser1.Navigate (addr) 

End Sub 

'------------------------------------------------------------ 

Sub web() 

Dim awb As New UserForm1 

awb.TextBox1 = " http://eng.sut.ac.th/ce/" 

awb.Show 

 

End Sub 
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2.5.1.2 การน าเข้าข้อมูล   
ค าสั่งในการ Input ข้อมูลต่าง ๆ ซึ่งอาจเป็น  ตัวเลข  อักขระ  จุด  มุมหรือ

อ่ืน ๆ  โดยประกอบด้วยรูปแบบฟังก์ชันในการ Input  ดังต่อไปนี้ 
1. Input  Interger ส าม ารถท าได้ โดยใช้  Function Getinteger ซึ่ ง เป็ น 

Function ใน Sunclass Utility ซึ่งจะต้องก าหนดตัวแปร  เพื่อมารับค่าที่
รับเข้ามาโดยมีรูปแบบดังนี้ Getinteger  (ตัวอักขระที่ต้องการแสดงบน 
Prompt)  

 
 
 
 
 
 

2.   Input Real  เป็นรูปแบบการน าเข้าข้อมูลในรูปตัวเลข ที่มีทศนิยมมี
ขั้นตอนคือ สร้าง Sub Program ขึ้นมา จากนั้นก าหนดตัวแปรเพื่อเก็บค่า
ของตัวเลข โดยการรับค่าตัวเลขทศนิยมนั้นจะต้องใช้ Function Getreal 
โดยมีรูปแบบดังนี้คือ Getreal (อักขระที่ต้องการรแสดงบน Prompt)  

 
 
 
 
 
 

 3. Input Point  ใช้ในการก าหนดตัวแปรท าหน้าที่เก็บจุดที่รับเข้ามา  โดย
จะต้องก าหนดเป็น Array 3 มิติ  เพื่อให้เหมาะสมกับพิกัดของจุดซึ่งเป็น
พิกัด 3 มิติ  จากนั้นจึงใช้ Funtion GetPoint ของ Sunclass Utility เพื่อ
รับข้อมูลจุดนั้นๆ โดยมีรูปแบบดังนี้  Get Point (จุดเร่ิมต้น,ข้อความที่
ต้องการแสดงบน Prompt) ซึ่งในส่วนของจุดเร่ิมต้นนั้นเราสามารถที่จะ
ก าหนดหรือไม่ก็ได้  

Sub inputint() 

   Dim count,i 

          count = ThisDrawing.Utility.GetInteger("Enter Int") 

          For i=0 To count 

                  ThisDrawing.Utility.Prompt (Str(i)+vbLf) 

          Next i 

 

Sub inputReal() 

   Dim r 

          r = ThisDrawing.Utility.GetReal("Enter Real") 

          ThisDrawing.Utility.Prompt (Str(r)+vbLf) 

End Sub 
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4.   Input Keyword  มีขั้นตอนด าเนินการโดย  Initialize UserInput ซึ่งเป็น 
SubClass หนึ่งของ ThisDrawing เพื่อก าหนดข้อมูลต่าง ๆ ที่ต้องการ 
และ คีย์เวิร์ดส าหรับข้อมูลนั้น ๆ โดย  initialize UserInput มีรูปแบบ
ดังนี้ Initialize User Input ล าดับของตัวอักษรของข้อมูลที่จะก าหนดให้
เป็น Keyword,List ของข้อมูล 

 
 
 
 
 
 
 
 

5.  Input String สามารถท าได้โดยการใช้  Function GetString ซึ่ ง เป็น 
Subclass Utility โดยมีรูปแบบดังนี้  GetString  (ให้ก าหนดว่าอักขระที่
รับเข้ามามีช่องว่างหรือไม่โดยก าหนดเป็น True หรือ False, ข้อความที่
ต้องการแสดงบน Prompt)  

 
 
 
 

 
 

 

Sub inputpoint() 

     Dim pt1(0 to 2) As Double 

     Dim pt2(0 to 2) As Double 

     Dim tmppt As Variant 

  

     tmppt = ThisDrawing.Utility.GetPoint("Enter Point") 

     pt1(0) = tmppt(0) 

     pt1(1) = tmppt(1) 

     ThisDrawing.Utility.Prompt(Str(pt1(0))+","+Str(pt1(1))+vbLf) 

 

End Sub 

 

Sub inpKey() 

    Dim KwordList As String 

    Dim  ret 

        kwordList = "Width Height Depth" 

        ThisDrawing.Utility.InitializeUserInput 1,kwordList 

              Dim retutnString As String 

        returnString = ThisDrawing.Utility.GetKeyWord("Enter  

a KeyWord (Height)(Width)(Depth)") 

        ret = MsgBox(returnString,vbOkOnly) 

End Sub 

 

Sub Basicinput() 

  Dim name As String 

  Dim ret 

      name = ThisDrawing.Utility.GetString(True,"Enter Name") 

      name = "hello" + name 

      ret = MsgBox(name,vbOkOnly) 

End Sub 
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π 

6.   GetCorner เป็นการก าหนดมุมของสี่เหลี่ยม โดยจะต้องก าหนดตัวแปร
เพื่อมารับค่าของมุมที่รับเข้ามา โดยมีรูปแบบคือ GerCorner (จุดเร่ิมต้น,
อักขระที่ต้องการแสดงเป็น Prompt)  

 
 
 
 
 
 
 
 

 

7.   Input Angle ท าได้โดยใช้  Function Getangle ใน Subclass Utility ซึ่ ง
เป็นส่วนหนึ่งของ Class ThisDrawing โดยมีรูปแบบของ Function คือ 
Getangle(จุดเร่ิมต้น,อักขระที่ต้องการแสดงเป็น Prompt) ในการใช้ 
Function นี้จะมีสิ่งที่ควรจะทราบไว้คือ ในการรับค่าโดยการ click แล้ว
ลากเส้นเอียงมุมที่ได้จะเป็นค่า  

 
 
 
 
  

8.  Casting คือขั้นตอนการใช้งาน entities แล้วเอาตัวข้อมูลมาใช้งาน มี
ขั้นตอนที่แทรกอยู่เรียกว่า casting   ท าหน้าที่แปลงจาก data type หนึ่ง 
ไปอีก type หนึง่ 

9.  Entity and Drawing Database ภายใน AutoCAD ท าหน้าที่ เก็บข้อมูล
แบบ hierarchy โดยจะเก็บในลักษณะ AutoCAD object  มีการจัดเก็บ
เป็น 2 model  คือ เก็บในรูปแบบของ model space  ก็คือ model ที่ใช้
เขียนแบบทั่วไป  อีกรูปแบบหนึ่งก็คือเก็บใน paperspace ซึ่งการเขียน
แบบส่วนใหญ่จะใช้รูปแบบแรกเป็นหลักหากต้องการค้น information 
กระท าได้โดยก าหนดให้  model space  เป็น  table และสามารถ  access 
database ได้ 

Sub inputCorner() 

   

     Dim pt1(0 to 2) As Double 

     Dim pt2(0 to 2) As Double 

     Dim tmppt As Variant 

  

     tmppt = ThisDrawing.Utility.GetCorner("Enter Point") 

     pt1(0) = tmppt(0) 

     pt1(1) = tmppt(1) 

     ThisDrawing.Utility.Prompt(Str(pt1(0))+","+Str(pt1(1))+vbLf) 

 

End Sub 

 

Sub inpAng() 

   Dim ang1 As Double 

     ang1 = ThisDrawing.Utility.GetAngle(,"Enter Angle") 

     ThisDrawing.Utility.Prompt(Str(ang1)+vbLf) 

End Sub 
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10.  Selection Set ท าหน้าที่เลือกข้อมูลที่อยู่บนหน้า Scene น าไปด าเนินการ
เปลี่ยนแปลงโดย  AutoCAD จะมีตัวแปรที่ชื่อว่า AcadSelectionSet  
สามารถก าหนดได้ 2 ลักษณะคือ  ถ้าไม่เคยถูกเรียกใช้มาก่อนต้อง
ด าเนินการ Add ก่อนด้วย Keyword หากเคยเรียกใช้มาก่อนแล้วก็ให้ใช้
วิธี  Item 

            2.5.1.3  การก าหนด  Entity 
การก าหนด  Entity ต่างๆ ของ AutoCAD โดยใช้ค าสั่งของ Visual Basic มีดงันี ้
 1.  AcadLine ใช้ส าหรับการสร้างเส้นตรง ในแนวคิดของ VBA บน 

AutoCAD มีพื้นฐานค าสั่ งการสร้างเส้นมาจาก Command Addline 
ตั วอย่ าง เช่ น เมื่ อ ต้ องการส ร้างวงกลมจาก  Command Addcircle  
ต้องการสร้าง  arc command Addarc ก็เป็นการบวกเส้นโค้งวิธีการ
สร้างเส้นโดยใช้รูปแบบค าสั่งดังนี้   

 
    Retval=oblject.Addline(StartPoint,EndPoint)  

 
 

2.   AcadArch  ใช้ส าหรับการสร้างเส้นโค้ง  สามารถท าได้โดยใช้ Function 
AddArcใน  SubClassModelSpace โดยมีรูปแบบค าสั่ง ดังนี ้ 

 

 
    AddArc(Center,Radius,StartAngle,EndAngle) 

 
โดยที่ Center คือ จุดศูนย์กลางของส่วนโค้ง  โดยจะต้องก าหนดเป็น Array 

3 มิติ Radius คือ รัศมีของส่วนโค้ง StartAngle คือมุม เร่ิมต้นของส่วนโค้ง  EndAngle คือ มุมที่
เคลื่อนที่จากมุมเร่ิมต้น 

3.  AcadCircle  การสร้างวงกลม  มีลักษณะคล้ายวิธีการพิมพ์ ค าสั่ ง 
Addcircle รูปแบบค าสั่ง 

 
    Retval=oblject.AddCircle(Center,Radius) 
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4.  AcadText การAddtext เป็นรูปแบบการจัดเก็บข้อมูลด้วยตัวอักษร
ข้อความ วิธีการท า Addtext ต้องมีการก าหนด  Style  รูปแบบค าสั่ง  

 

 
    Retval = object.Addtext(Textstring,Insertpoint,Height) TextString 

 
         

ข้อความที่ เราต้องการ Add  เข้าไป  Insertpoint  =  การก าหนดต าแหน่ง
เร่ิมต้นของตัวหนังสือปกติ  คือ  ซ้ายล่าง  Height   คือ  ความสูงของตัวหนังสือ  

5.  การ Add Block  คือการน าเข้าข้อมูลโดยการจัดท า  Block ขึ้นมา  ข้อมูล
นี้จะประกอบด้วย Attribute 1 ตัว โดยใช้ค าสั่ง Insert Box ซึ่งเราจะท า
การ GetAttribute ออกมาโดยใช้ค าสั่ง GetAttribut 

2.5.1.4  การควบคุม  Layer  และ Entity    
คือการก าหนดและควบคุมลักษณะต่าง ๆ ซึ่งประกอบไปด้วย 
1. การควบคุม Layer เป็นกระบวนการที่ใช้ในการควบคุมการเขียนแบบ 

วิธีการอยู่ใน Component acadlayer หลัก layer เป็นส่วนประกอบหนึ่ง
ของ  Drawing จึ ง เป็ นส่ วนหนึ่ งของ  Database ของ Drawing ก าร
ควบคุม Layer เป็นสิ่งที่ใช้บ่อยในการจัดท า Application ต่างๆ Layer 
เป็นตัวควบคุมในเร่ืองของการ - Linetype - Color - Print หรือ Prot ใน
ส่วนที่เป็น Lineobj สามารถก าหนด Layer ได้ต้องสร้าง  Layer   ขึ้นมา
ก่อน  

2.  การควบคุม Entity การควบคุมเส้นและเอนติตี้ใดๆ ให้มีคุณสมบัติตาม
ต้องการ เช่น Layer, Color  เมื่อเราท าการก าหนด Add line เข้าไปยัง 
Database ที่ เราเขียนแบบหรือ Drawing ของ AutoCAD Lineobj ที่เกิด
จาการ Set สามารถก าหนดคุณสมบัติได้ โดย lineObj.Color= 1 (คือ สี
แดง)  

3.  กระบวนการ Zoom เป็นกระบวนการที่ใช้บ่อยในการท า User Interface 
โดย Function ที่ ใช้นิ ยมใช้กันคือ Function Zoom Window ซึ่ ง เป็น 
Function หนึ่งใน SubClass Application ของ Class ThisDrawing 

2.5.1.5 การสร้าง Application   
การเขียนชุดค าสั่ ง  VBA  บน  AutoCAD ให้ เชื่ อมโยงกับโปรแกรม 

Microsoft  Excel  เพื่อช่วยในการรับส่งข้อมูลระหว่างกัน  สามารถด าเนินการได้ดังนี้ 
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1. ก าหนดให้โปรแกรมมีลักษณะการท างานเป็นแบบ  window   โดย  
excel  เป็น opject อยู่ภายนอก  จะมีการ declare  MyXL ค าสั่งส าคัญคือ 
GetObject   สามารถที่จะท าการค านวณวิเคราะห์ออกแบบโครงสร้างที่
ซับซ้อนไปไว้ใน excel ได้   แล้วค่อยส่งผลการค านวณกลับมาที่  
AutoCAD 

 
 
 
     
 
 
 
 
 
 
 
 
 
 

 
2. ด าเนินการน าเข้าข้อมูลใน  AutoCAD โดยเขียนชุดค าสั่ง EOF  เพื่ออ่าน

จนหมด  file และวิธีการอ่านจะใช้ line input อ่านเป็นบรรทัดเข้ามา 
และจะใช้วิธีการ scan บรรทัดนั้นที่เข้ามา string ที่เข้ามาจะมีการแบ่ง
โดยใช้ space  เป็นตัวคั่น   

3. ด าเนินการเชื่อมโยงฐานข้อมูล (Database) โดยเขียนชุดค าสั่ง  VBA 
เรียกใช้ DataBase Object  ที่เรียกว่า  DAO  ซึ่งเป็น Object  ที่พัฒนาขึ้น
มาอีกระดับ  จากเดิมที่ใช้ ODBC และการใช้  DAO  มีวิธีการติดต่อกับ
ฐานข้อมูลที่ง่ายขึ้นด้วย  

Sub GetExcel() 

    Dim MyXL As Object  ' Variable to hold reference 

    Dim avar As String 

     

    ' to Microsoft Excel. 

    Dim ExcelWasNotRunning As Boolean   ' Flag for final release. 

' Test to see if there is a copy of Microsoft Excel already 

running. 

    On Error Resume Next    ' Defer error trapping. 

    Set MyXL = GetObject(, "Excel.Application") 

    If Err.Number <> 0 Then ExcelWasNotRunning = True 

    Err.Clear   ' Clear Err object in case error occurred. 

    Set MyXL = GetObject("c:\book1.XLS") 

    MyXL.Application.Visible = True 

    MyXL.Parent.Windows(1).Visible = True 

    avar = MyXL.Worksheets(1).Cells(2, 1).Value 

MyXL.Worksheets(1).Cells(2, 1).Value = 12 

MyXL.Worksheets(1).Cells(3, 1).Value = "=A1" 

' close 

    If ExcelWasNotRunning = True Then 

        MyXL.Application.Quit 

    End If 

    Set MyXL = Nothing  ' Release reference to the 

' application and spreadsheet. 

End Sub 
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 เมื่อผู้ศึกษาได้เรียนรู้และมีความเข้าใจประวัติความเป็นมา ความจ าเป็น 
โครงสร้างพื้นฐาน ค าสั่งต่างๆ และหลักการใช้งาน Editor ของ VBA ส าหรับ AutoCAD แล้ว ใน
ขั้นตอนต่อไปคือการศึกษาและลงมือเขียนชุดค าสั่งเพื่อพัฒนาโปรแกรมด้วยตัวเอง 

2.5.2   การเขียนชุดค าสั่ง VBA บน Microsoft Excel 
Microsoft Excel  มีคุณลักษณะการท างานที่รองรับการค านวณที่ซับซ้อนได้  จึงมี

ความเหมาะสมน ามาใช้ในการพัฒนาโปรแกรมให้สามารถท าการค านวณวิเคราะห์โครงสร้างและ
ออกแบบโครงสร้างคอนกรีตเสริมเหล็กได้  ด้วยคุณสมบัติของโปรแกรม Excel ในการบันทึกการ
ท างาน (Macro) หรือการเขียนรหัสชุดค าสั่ง Visual Basic for Application (VBA)  

2.5.2.1 ส่วนประกอบของหน้าต่าง  Visual Basic Editor 
หน้าต่างหลัก  Visual Basic Editor ใช้ในการสร้าง  การแก้ไขฟอร์มต่างๆ  
1)   การก าหนดคุณสมบัติของวัตถุ  
      ในการสร้างรหัสค าสั่ง VBA ในโปรแกรม  Excel  นั้น จะกระท าใน

หน้าต่าง Visual Basic Editor ซึ่งการเรียกหน้าต่างออกมานั้น ท าได้ดังนี้ 
 1. คลิกที่เมนูบาร์เลือก Tools>Macro>Visual Basic Editor  
 2. จากนั้นหน้าต่าง Visual Basic Editor จะปรากฏขึ้น 

 
 

 
 
 

 

รูปที่  2.19  หน้าต่าง  Visual Basic Editor 
 

2)   ส่วนประกอบ Window ของ Visual Basic Editor 
2.1)  เมนูบาร์  
2.2)  Project Explorer คือ หน้าตา่งของโปรเจค 
2.3)  Properties Window คือ หน้าต่างคุณสมบัติของออฟเจคต่างๆ 
2.4)  คือพื้นที่ส าหรับเขียนรหัสค าสั่ง 
2.5)  ออฟเจคของสมุดงาน 
2.6)  ฟอร์มต่างๆ ที่สร้างขึ้น 
2.7)  Module คือ ที่เก็บรหัสค าสั่งต่างๆที่เขียนขึ้นมา 
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2.8)  ปุ่ม Design mode 
2.9)  ปุ่มใช้แสดงหน้าต่าง Project Explorer 
2.10)  ปุ่มใช้แสดงหน้าต่าง Properties Window 
2.11)  ปุ่มใช้แสดงหน้าต่าง Object Browser 
2.12)  ปุ่ม ToolBox คือ กล่องเคร่ืองมือต่างๆ ที่ใช้ในการสร้างองค์ 

ประกอบ ของฟอร์ม 
2.13)  ปุ่ม DropDownList ของ Object 
2.14)  ปุ่ม DropDownList ของ Procedure 

3)   การเขียนชุดค าสั่ง   
 
 
 
 
 
 
 
 
 
 
 

รูปที่  2.20  ส่วนประกอบ  Visual Basic Editor 
 

2.5.2.2 การสร้างชุดค าสั่ง 
สามารถท าได้ 2 วิธี โดย 
1.   การบันทึกการท างาน (Macro)   งานค านวณวิเคราะห์ออกแบบ

โครงสร้างคอนกรีตเสริมเหล็กมีความซับซ้อน  อาจก่อให้เกิดความ
ล่าช้าและเกิดความผิดพลาดที่ เรียกว่า human error  ดังนั้นการสร้าง  
Macro จะช่วยให้ปัญหาต่างๆ เหล่านั้นลดน้อยลงไป การเขียนมาโคร
นั้น  แท้จริงแล้วก็คือการสร้างรหัสค าสั่งนั่นเอง  เพราะเนื้อในของ
มาโครก็คือรหัสค าสั่ง VBA แต่เป็นการสร้างรหัสค าสั่งที่ไม่ต้องเขียน
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ค าสั่ง เพียงแต่ใช้การบันทึกการท างาน จากนั้นโปรแกรมก็จะแปลงเป็น
รหัสค าสั่งให้อัตโนมัติ  ซึ่งมีความสะดวก  รวดเร็วและเหมาะกับผู้ใช้ที่
ไม่สามารถเขียนโปรแกรมค าสั่งได้  แต่ก็มีข้อจ ากัดในเร่ืองของความ
ยืดหยุ่น  ความซับซ้อน เมื่อผู้ใช้ต้องการให้มีเงื่อนไขต่างๆ ในการ
ประมวลผล  
1.1 การบันทึกมาโครสามารถท าได้ดังนี้ 

1. คลิกที่เมนูบาร์เลือก Tools>Macro>Record New Macro…  
 

 
 

 
 
 

รูปที่  2.21   การบันทึก  Macro 
 

2. จะปรากฏไดอะล็อก Record Macro ขึ้นมา ที่ช่อง Macro name 
ให้ตั้งชื่อมาโคร ตามที่ต้องการหรือจะใช้ชื่อ Macro1 ก็ได้ แล้ว
กดปุ่ม OK เพื่อเร่ิมต้นการบันทึกมาโคร 
 

 
 
 
 
 

 
 

 

รูปที่  2.22   การตั้งชื่อ  Macro 
 

3. ด าเนินการบันทึก การท างานใดๆ บนแผ่นงาน (work sheet) 
4. หยุดการบันทึกมาโคร Tools>Macro>Stop Recording ดังรูป 
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รูปที่  2.23   หยุดการบันทึก Macro 
 

5. เมื่ อ ห ยุ ด ก ารบั น ทึ ก แ ล้ ว  ค ลิ ก เลื อ ก ที่ เม นู บ า ร์ เลื อ ก 
Tools>Macro> Visual Basic Editor ดังรูป เพื่ อเข้าไปดูรหัส
ชุดค าสั่ง 

 
 
 

 
 
 

รูปที่  2.24   การเข้าดูรหัสชุดค าสั่ง VBA 
 

6. เมื่อหน้าต่าง Visual Basic Editor ปรากฏขึ้น ให้สังเกตทางด้าน
ซ้ายของหน้าต่างจะมีหน้ าต่าง Project Explorer ให้คลิกที่
โฟลเดอร์ Modules >Module1 รหัสค าสั่ง VBA ที่ถูกสร้างจาก
การบันทึกก็จะปรากฏขึ้นมาดังรูป 

 
 
 
 
 

 
 
 
รูปที่  2.25   ชุดค าสั่ง VBA 
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7. ขั้นตอนการเรียกมาโครมาใช้งาน นัน้มีอยู่  2 วิธีคือ 
วิธีที่ 1 คลิกเลือกเซลล์หรือช่วงของเซลล์ที่ต้องการใช้มาโคร  

แล้วไปที่เมนูบาร์ คลิกเลือก  Tools>Macro>Macros…จากนั้นไดอะล็อก Macro จะปรากฏขึ้นมาให้
เลือกมาโครที่ต้องการ  แล้วคลิกที่ปุ่ม Run  มาโครที่บันทึกไว้ก็จะท างานทันทีดังรูป 

 
 
 
 

 
 

รูปที่  2.26   การเรียกใช้   Macro  วิธีที่ 1 
 

 
 
 
 
 
 
 

 

 
 
 
 
 

รูปที่  2.27   การ Run  Macro 
   

 

วิธีที่  2  ด าเนินการโดยก าหนดมาโครให้กับวัตถุ  (Object) 
ต่างๆ  เช่น รูปภาพ ปุ่ม ไอคอน เป็นต้น จากตัวอย่างจะเลือกใส่รูปหน้ายิ้มจาก AutoShapes น ามา
วาดลงบนแผ่นงาน จากนั้นให้คลิกขวาที่รูปเพื่อก าหนดมาโครให้กับรูปจากนั้นไดอะล็อก Assign 
Macro จะปรากฏขึ้นให้คลิกเลือกชื่อมาโครที่ต้องการให้ท างาน  แล้วกดปุ่ม OK 
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รูปที่  2.28   ก าหนดมาโครให้กับวัตถุ (Object) 
 

 
 

 
 

 
 
 

 

 
 
 
 

รูปที่  2.29  การ  Assign Macro  
   

หลังจากที่ก าหนดมาโครให้กับวัตถุ เช่น รูปภาพ  ปุ่ม หรือ
ไอคอนที่เราสร้างขึ้นมาแล้ว จะสังเกตเห็นว่าเมื่อเอาเมาส์ไปวางไว้ที่รูปเคอร์เซอร์จะเปลี่ยนเป็นรูป
มือ  แสดงให้ทราบว่าวัตถุนี้ได้มีการก าหนดมาโครแล้ว 



34 
 

8. ขั้นตอนการทดสอบมาโคร หลังจากที่ก าหนดมาโครให้กับ
รูปภาพแล้ว  ให้ทดลองใช้มาโครด้วยการเลือกเซลล์หรือช่อง
ของเซลล์  หรือเลือกทั้งแถวแล้วคลิกที่รูปภาพ  จะเห็นว่าช่วง
ของเซลล์ที่เราเลือกจะมีการเปลี่ยนคุณสมบัติของเซลล์  ตามที่
บันทึกไว้ 

2.  การสร้างชุดค าสั่งด้วยการเขียน VBA 
เป็นวิธีที่ช่วยให้ผู้ใช้สามารถพัฒนาโปรแกรมให้สามารถตอบสนองให้

โปรแกรมท างานได้ตามต้องการและมีความยืดหยุ่นและซับซ้อนได้มากกว่าการบันทึกมาโคร โดยมี
วิธีการดังนี้ 

1.   เปิดหน้าต่าง Visual Basic Editor ขึ้นมา โดยการคลิกที่ เมนูบาร์
เลือก Tools>Macro>Visual Basic Editor ดังรูป 

 
 
 
 

 
 

รูปที่  2.30   การเปิดหน้าต่าง Visual Basic Editor 
 

2.  เมื่อหน้าต่าง Visual Basic Editor ปรากฏขึ้นมา  ให้คลิก เลือก 
Insert>Module จะมี Module1 ปรากฏขึ้นมา  ให้คลิกที่เมนูบาร์อีก
คร้ัง คลิกเลือก Insert>Procedureจะมีไดอะล็อก Add Procedure 
ปรากฏขึ้นมา  ให้ตั้งชื่อโปรแกรมในช่อง Name ซึ่งในตัวอย่างตั้ง
ชื่อเป็น  EXAMPLE2 

 

 
 
 
 
 
 

รูปที่  2.31   การ Add Procedure 
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รูปที่  2.32   การตั้งชื่อโปรแกรม   
 
 

 
 

 
 

 
 
รูปที่  2.33   ค่าเร่ิมต้นของโปรแกรม  EXAMPLE2 
 

3.  ให้ พิ ม พ์ ค าสั่ ง ต่ อ ไปนี้ ล งใน ช่ อ งว่ า ง  ระห ว่ าง  Public Sub 
EXAMPLE2() กับ End Sub   

 
 
 
 
 
 
 
 

Public Sub EXAMPLE2()  
Selection.Interior.ColorIndex = 6 
MsgBox (Selection) 
End Sub 
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รูปที่  2.34   ชุดค าสั่งโปรแกรม  EXAMPLE2 
 

4. กลับไปที่หน้าต่างเวิร์คชีทเอ็กเซลล์  เพื่อทดสอบโปรแกรมด้วยการ
สร้างวัตถุ เช่น รูปหน้ายิ้ม ปุ่ม หรือไอคอนต่างๆ แล้วก าหนด
โปรแกรมให้กับวัตถุ ซึ่งมีวิธีการเหมือนกับตัวอย่างที่ 1 จากนั้น
ลองคลิกเลือกชื่อผลิตภัณฑ์ในข้อมูลตัวอย่าง แล้วกดที่รูปหน้ายิ้ม 
จะเห็นว่าเซลล์ที่คลิกเลือกจะมีสีที่ เซลล์และมีไดอะล็อกแสดง
ข้อความที่อยู่ในเซลล์ที่เลือก 

 

 
 
 
 
 
 
 
 
 

 

 
 

รูปที่  2.35   การ Run  โปรแกรม  EXAMPLE2 

 
2.5.2.3  การเรียกใช้หรือทดสอบโปรแกรมได้โดยมีวิธีการดังนี้ 

        1.  วิธีใช้ปุ่มค าสั่ง Run 
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               1.1 ใช้ปุ่มค าสั่ง Run ที่หน้าต่างเวิร์คชีทเอ็กเซลล์  โดยที่เมนูบาร์คลิก
เลือก Tools>Macro>Macros จะมีไดอะล็อก Macro ขึ้นมาให้กด
ปุ่ม Run  

 
 

 
 
 
 
 
 
 
 
 

รูปที่  2.36   การ Run  โปรแกรม  1 
 

  1.2 ใช้ปุ่ม Run ที่หน้าต่าง Visual Basic Editor เมื่อต้องการเรียกใช้
โปรแกรมใด ให้เอาเมาส์ไปคลิกในพื้นที่ส่วนของโปรแกรมที่
ต้องการใช้งาน จากนั้นให้คลิกที่ปุ่ม Run Sub/UserForm   ดังรูป 

 
 
 
 
 
 
 
 
 

 
 

รูปที่  2.37   การ Run โปรแกรมที่หน้าต่าง Visual Basic Editor 
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 2.   การก าหนดโปรแกรมให้กับวัตถุ 
                               โดยก าหนดโปรแกรมให้กับวัตถุ เช่น รูปภาพ ปุ่ม หรือไอคอนต่างๆ 

ตัวอย่าง  เช่น ก าหนดโปรแกรม ชื่อ Program1 ให้กับรูปหน้ายิ้มหลังจากที่สร้างโปรแกรมเสร็จแล้ว 
ให้กลับไปที่หน้าเวิร์คชีทเพื่อใส่รูปหน้ายิ้ม  จากนั้นให้คลิกขวาที่รูปจะมีเมนูขึ้นมา  ให้เลือกค าสั่ง 
Assign Macro ก็จะมีไดอะล็อก Assign Macro ขึ้นมาให้เลือกโปรแกรมที่ต้องการใช้ แล้วกดปุ่ม OK 

 
 
 
 
 
 
 
 
 

รูปที่  2.38   การ  Run โปรแกรม 
 

3.   การสร้างค าสั่งในเมนูบาร์ (Menu Bar) 
                                  อีกวิธีหนึ่งส าหรับการเรียกใช้งานโปรแกรมหรือมาโครที่สร้างไว้  ก็

คือ สร้างเป็นค าสั่งในเมนูบาร์  ซึ่งในตัวอย่างนี้จะเรียกใช้โปรแกรม Program1  
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่  2.39   การสร้างค าสั่งในเมนูบาร์ ขั้นตอนที่ 1 – 5 
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จากรูปที่  2.39   การสร้างค าสั่งในเมนูบาร์ (Menu Bar)  สามารถท าได้โดย
การสร้างเป็นค าสั่งแทรกไว้ในเมนู Tools ดังนี ้

1. คลิกเลือก Tools 
2. คลิกเลือก  Customize… 
3. เมื่อไดอะล็อก Customize  เปิดขึ้นมาให้คลิกเลือกแท็บ  

Commands 
4. ในช่อง Categories ให้คลิกเลือก Tools 
5. ที่ช่อง Commands ให้คลิกเลือก Custom           

 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่  2.40   การสร้างค าสั่งในเมนูบาร์ ขั้นตอนที่ 6 – 8 
 

จากรูปการสร้างค าสั่งในเมนูบาร์ (Menu Bar)  สามารถท าได้โดยการสร้าง
เป็นค าสั่งแทรกไว้ในเมน ูTools  ดังนี ้

6. คลิกเม้าส์ที่ Custom ค้างเอาไว้แล้วลากไปที่เมนู Tools 
7.  จากต าแหน่ง Tools ให้ลากเม้าส์ลงมาในต าแหน่งที่ต้องการ 
8. ในตัวอย่างนี้ จะลากเม้าส์วางไว้ใต้ค าสั่ง Macro จากนั้นให้ปล่อย

เม้าส์จะได้ Custom มาอยู่ในเมนูแล้ว 



40 
 

 

 
 
 
 
 

 
 
 
 
 

รูปที่  2.41   การสร้างค าสั่งในเมนูบาร์  ขั้นตอนที่ 9 – 11 
 

จากรูปการสร้างค าสั่งในเมนูบาร์ (Menu Bar)  สามารถท าได้โดยการสร้าง
เป็นค าสั่งแทรกไว้ในเมน ูTools  ดังนี ้

9. คลิกขวาที่ Custom เพื่อท าการเปลี่ยนชื่อ 
10. 10. จะมี เมนูปรากฏขึ้นให้คลิกที่  Name: เพื่ อเปลี่ยนชื่อเป็น 

Program1 
11. จากนั้นคลิกเลือกที่ค าสั่ง Assign Macro… 
12. ไดอะล็อก Assign Macro จะปรากฏขึ้นให้คลิกเลือกโปรแกรมที่

ได้สร้างไว้   ซึ่งในตัวอย่างนี้ให้เลือก  โปรแกรม Program1  แล้ว
กดปุ่ม OK 

 
 
 
 
 

 
 
 
 
 
 

รูปที่  2.42   การติดตั้งค าสั่งในเมนูบาร์ 
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4.   วิธีการสร้างทูลบาร์ (Tool Bar)  ขึ้นมาใหม่   
           

 
 
 
 
 
 
 
 
 
 
 
 

รูปที่  2.43   การสร้างค าสั่งทูลบาร์  ขั้นตอนที่ 1 – 5 
                                                

  เพื่อความสะดวกรวดเร็วสามารถท าได้โดย 

1. ที่เมนูบาร์ให้คลิก Tools>Customize  
2. เมื่อไดอะล็อก Customize ปรากฏให้คลิกแท็ป Toolbars 
3. 3.  คลิกปุ่ม New… เพื่อสร้างทูลบาร์ใหม่ 
4. ไดอะล็อก New Toolbar จะปรากฏขึ้น ให้ตั้งชื่อให้กับทูลบาร์ ใน 

ตัวอย่างนี้ตั้งชื่อเป็น MyProgram จากนั้นให้คลิกปุ่ม OK 
5. จะได้ทูลบาร์ใหม่ขึ้นมา 
6. 6.  คลิกที่แท็ป Commands 
7. ในช่อง Categories ให้เลือก Tools 
8. ในช่อง Commands ให้เลือกปุ่ม Custom ลากไปไว้ที่ทูลบาร์ใหม่ 
9. ที่ทูลบาร์ใหม่มีปุ่มค าสั่งขึ้นมาแล้ว ให้คลิกขวาที่ปุ่ม Custom 
10. จะปรากฏเมนูขึ้นมาให้เลือกที่ Name ตั้งชื่อให้ปุ่มเป็น Program 1 
11. ให้คลิกเลือกค าสั่ง Assign Macro.. จะมีไดอะล็อกขึ้นมาให้คลิก

เลือกโปรแกรม Program 1 
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รูปที่  2. 44   การสร้างค าสั่งทูลบาร์  ขั้นตอนที่ 6 – 11 
 

 
 
 
 
 
 
 
 
 
 
 
 

รูปที่  2. 45   การติดตั้งค าสั่งในทูลบาร์ 
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รูปที่  2.46  ทูลบาร ์

 

12. เมื่อได้ก าหนดโปรแกรมให้กับปุ่มแล้ว ให้คลิกซ้ายที่ทูลบาร์ค้าง
เอาไว้ แล้วลากไปไว้ที่แถบทูลบาร์ด้านบน 

5. วิธีการสร้างคีย์ลัด (Shotcut Key) 
                                         การเรียกใช้โปรแกรมอีกวิธีหนึ่งคือ การสร้างคีย์ลัด ด้วยการกดปุ่ม 
Ctrl+ปุ่มอักษร 
 

 
 
 
 
 
 
 
 
 

รูปที่  2.47  การติดตั้งคีย์ลัด (Shotcut Key) 
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1. ที่ เมนู ให้ คลิก  Tools>Macro>Macros..จะปรากฏไดอะล็อก 
Macro ขึ้นมาให้เลือกโปรแกรมที่ต้องการสร้างคีย์ลัด ในตัวอย่าง
นี้เลือกโปรแกรม Program1 

2. จากนั้นให้เลือกปุ่ม Options  ก็จะมีไดอะล็อก Macro Options 
ปรากฏ 

3. ก าหนดอักษรที่จะใช้ในการเรียกโปรแกรม 
4. ในช่อง Description: ให้พิมพ์ประโยคที่ใช้อธิบายความหมายของ

โปรแกรมเสร็จแล้วให้คลิกที่ปุ่ม OK ก็จะได้คีย์ลัดส าหรับ
เรียกใช้โปรแกรมแล้ว  

2.5.2.4  ยกเลิกการติดตั้งมาโคร 
  การลบมาโครหรือ  VBA  ที่ไม่ต้องการใช้งานสามารถท าได้ 2  วิธี  คือ  
 1.  ลบโดยผ่านไดอะล็อก Macros 
 1.1 ที่เมนูบาร์ให้คลิกเลือก Tools>Macro>Macros 
 

 
 
 
 
 
 

รูปที่  2.48  ยกเลิกการติดตั้งมาโคร  ผ่านไดอะล็อก Macros 
 

 1.2  ไดอะล็อก Macro จะปรากฏขึ้นมา ให้คลิกเลือกชื่อมาโครหรือ 
โปรแกรมที่ต้องการลบ จากนั้นให้คลิกปุ่ม Delete จากรูปตัวอย่าง
ต้องการลบมาโครที่ชื่อ Program3 
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รูปที่  2.49  การลบ Macros หรือ VBA 
 

 2.   ลบมาโครหรือ VBA  โดยเข้าไปลบที่หน้าต่าง Visual Basic Editor 
  2.1 ที่เมนูบาร์ให้คลิกเลือก Tools>Macro>Visual Basic Editor 

 
 
 
 
 

 

รูปที่  2.50  การลบมาโครหรือ VBA  ผ่าน  Visual Basic Editor  
 

    2.2 เมื่อเข้าสู่หน้าต่าง Visual Basic Editor แล้ว ให้เลือกโปรแกรมที่
ต้องการลบโดยการคลิกลากส่วนของโปรแกรม  แล้วคลิกขวาเพื่อ
เลือกค าสั่ง Cut โปรแกรมก็จะถูกลบทันที 
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รูปที่  2.51   การลบมาโครที่บรรทัดชุดค าสั่งของ  Visual Basic Editor 
 

2.5.2.5 การลบโมดูล 
 โมดูล Module เป็นที่เก็บมาโคร หรือโปรแกรมที่ได้เขียนไว้ ซึ่งอาจมีหลาย
โปรแกรมที่เขียนเก็บไว้ เช่น Module1 เก็บโปรแกรมไว้ 3 โปรแกรม ดังนั้นการลบ Module1 ก็
เท่ากับได้ลบโปรแกรมทั้งหมดในโมดูลไปด้วย ดังนั้นก่อนการลบโมดูลแต่ละคร้ังต้องตรวจสอบ
ให้ถี่ถ้วนก่อน  การลบโมดูลนั้นสามารถท าได้ดังนี้ 

1. เปิ ดหน้ าต่ าง   Visual  Basic  Editor   ด้ วยก ารคลิ ก เลื อก   Tools> 
Macro> Visual Basic Editor  

2. ที่หน้าต่าง  Visual  Basic  Editor  ให้ เลือกคลิกขวา  เลือกโมดูลที่
ต้องการลบแล้วเลือกค าสั่ง Remove Module 
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รูปที่  2.52  การลบโมดูลผ่านหน้าต่าง Visual Basic Editor 
 

 
 
 
 
 
 

 

รูปที่  2.53  ยืนยันการลบโมดูล 
 

3. เมื่อคลิกเลือกค าสั่ง Remove Module1 จะปรากฏไดอะล็อกขึ้นมาถ้า
เลือกปุ่ม Yes คือ ลบโมดูลโดยมีการส่งออกโมดูลไปเก็บไว้ที่อ่ืน  ถ้า
เลือกปุ่ม No คือ ลบโมดูลโดยไม่มีการส่งออกโมดูลไปเก็บไว้ที่อื่น 

2.5.2.6  การหยุดโปรแกรม 
 กรณีต้องการหยุดโปรแกรมเนื่องจากโปรแกรมท างานไม่ออกจากรูปหรือ
ต้องการหยุดการท างาน หรือหยุดเพื่อดูค่าของตัวแปรต่างๆ สามารถท าได้โดยกดปุ่ม <control> + 
<break> ในขณะโปรแกรมก าลังท างาน  

Continue   หมายถึง  ให้โปรแกรมท างานต่อไป 
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End      หมายถึง  ให้โปรแกรมจบการท างาน 
Debug     หมายถึง  ให้โปรแกรมแสดงค าสั่ง Source code  
Help      หมายถึง  ส่วนให้ความช่วยเหลือ 

 
 
 
 
 
 
 
 
 

รูปที่  2.54   การหยุดโปรแกรม 
 

2.5.2.7  การป้องกันมาโคร (enable and disable macro) 
 ถึงแม้ว่า การเขียนค าสั่ง VBA หรือการสร้างมาโคร จะมีประโยชน์ต่อการ
พัฒนาการท างานของโปรแกรมก็ตาม แต่อีกด้านหนึ่งการเปิดใช้ความสามารถของค าสั่ง ก็เป็นการ
เปิดช่องให้ไวรัสต่างๆที่เขียนด้วยค าสั่ง VBA เข้ามาก่อกวนหรือท าอันตรายกับเคร่ืองคอมพิวเตอร์ 
หรือไฟล์งานที่ได้ท าไว้ได้เหมือนกัน ดังนั้นการป้องกันการท างานของค าสั่ง VBA หรือมาโคร ก็
เป็นเร่ืองส าคัญที่ผู้ใช้งานจ าเป็นต้องทราบเพื่อหาทางป้องกัน ในโปรแกรมเอ็กเซลล์สามารถป้องกัน
การท างานของรหัสค าสั่ง VBA หรือมาโครไม่ให้ท างานได้โดยการก าหนดค่าดังนี้ 

1.   คลิกที่เมนูบาร์ File>Options 
2.   เลือกแท็บ Trust Center  คลิกที่ปุ่ม  Trust Center  Setting 
3.   ทางเลือกของระดับความปลอดภัย 4 ระดับ คือ 

3.1 Disable all macros without notification หมายถึง ยก เลิกการรัน
โค้ดและไม่มีการแจ้งเตือน  ถือเป็นการป้องกันแบบเด็ดขาด 

3.2 Disable all macros with  notification หมายถึง ยกเลิกการรันโค้ด
แต่มีการแจ้งเตือนเพื่อให้เราเป็นผู้เลือก เป็นตัวเลือกที่ควรใช้งาน 

3.3  Disable all macros except digitally signed macros  ห ม า ย ถึ ง 
ยกเลิกการรันโค้ด  ยกเว้นมาโครที่มีลายเซ็น 
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3.4  Enable all macros (not recommended; potentially dangerous code 
can run)  หมายถึง ให้รันโค้ดได้ทันทีที่เปิดไฟล์ Excel เป็นตัวเลือก
ที่ไม่ควรเลือกเป็นอย่างยิ่ง ยกเว้นเพียงกรณีเดียวเท่านั้น คือ เปิด
ไฟล์ที่น่าเชื่อถือว่าปลอดภัย 

 
 

 
 

 
 
 
 
 
 

รูปที่  2.55   การตั้งค่า  Security Level 
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บทที ่3 
วิธีด ำเนินกำรศึกษำ 

 
 การพัฒนาโปรแกรมส าหรับการวิเคราะห์  ออกแบบและเขียนแบบโครงสร้างพื้น-คาน
คอนกรีตเสริมเหล็ก  ด้วย VBA บน  AutoCAD  และ Microsoft Excel  มีขั้นตอนวิธีการศึกษาดังนี้ 
 

3.1 ก ำหนดตัวอย่ำงแบบก่อสร้ำงเพื่อใช้ในกำรศึกษำ 
ภายใต้ขอบเขตของการศึกษา  ได้ก าหนดตัวอย่างแบบก่อสร้างเพื่อใช้เป็นข้อมูลน าเข้าจาก

การเขียนแบบแปลนอาคาร  ในรูปแบบของกราฟิกและตัวเลข  โดยการอ้างอิงแบบมาตรฐานบ้าน
เพื่อประชาชน พ.ศ.2559 ของกรมโยธาธิการและผังเมือง กระทรวงมหาดไทย จ านวน 2 แบบ ดังนี้  

1.  แบบบ้านครอบครัวไทยร่วมสมัย 2   พื้นที่ใช้สอย 120 ตารางเมตร 
2.  แบบบ้านครอบครัวไทยร่วมสมัย 6   พื้นที่ใช้สอย   70 ตารางเมตร 
 

 

 

 

 

รูปที่  3.1  ตัวอย่างแบบก่อสร้างเพื่อใช้ในการศึกษา 
 

3.2 กำรพัฒนำโปรแกรม   
3.2.1 การวิเคราะห์ (Analysis)  เป็นขั้นตอนที่มีความส าคัญเป็นอย่างยิ่ง  เน่ืองจากก่อนที่จะ

พัฒนาโปรแกรมใดก็ตาม จะต้องวิเคราะห์ระบบงานปัจจุบันและความต้องการของ
ระบบงานใหม่  เพื่อน ามาเป็นรายละเอียดในการพัฒนาโปรแกรม  โดยเขียนขั้นตอน
การวิเคราะห์ด้วย  Data Flow Diagram (DFD) ใช้สัญลักษณ์รูปภาพแสดงการไหล
ของข้อมูลระหว่างกระบวนการต่างๆ ในระบบ  ท าให้เห็นภาพรวมว่าข้อมูลที่น าเข้า
มาจากแหล่งไหนและปลายทางจะไปที่ใด แผนผังดังกล่าวเป็นข้อมูลที่มีความส าคัญ  
ในอนาคตสามารถช่วยให้ผู้ที่สนใจศึกษาการท างานของระบบได้ง่าย ช่วยลด
ระยะเวลาในการศึกษาเพื่อท าการปรับปรุงและพัฒนาโปรแกรมได้อย่างต่อเนื่อง    

 



51 
 

แผนผัง  DFD โปรแกรมวิเครำะห์ ออกแบบและเขียนแบบโครงสร้ำงพื้น-คำนคอนกรีตเสริมเหล็ก 
 

 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

เร่ิมต้นโปรแกรม 
ผ่าน  Menu  และ  Toolbar 

 

น าเข้าข้อมูล 
 Project 
 Drafting 
 Criteria of design 

ประมวลผล 
 Analysis of 

Structure 
 R.C. design 

 
 

 Drawing 
 Calculation sheet 
 Analysis & RC design 

 

 Drawing 
 Calculation sheet 
 Analysis & RC design 

 

สิ้นสุดการท างาน 
โปรแกรม 
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3.2.2 การออกแบบ (Design) คือ ขั้นตอนที่น าผลจากการวิเคราะห์มาใช้ในการออกแบบ
โปรแกรมตามที่ต้องการ   

3.2.3 การพัฒนา (Development) คือ ขั้นตอนการเขียนโปรแกรมด้วยภาษาคอมพิวเตอร์ 
โดยเลือกใช้ภาษาและฐานข้อมูลที่มีความเหมาะสมและง่ายต่อการปรับปรุงแก้ไข
ภายหลัง     

3.2.4 การทดสอบ (Testing) เมื่อท าการพัฒนาโปรแกรมส าเร็จเรียบร้อยแล้ว ก่อนที่จะ
น าไปติดต้ังเพื่อใช้งานจริงจะต้องท าการทดสอบ  เพื่อตรวจสอบความถูกต้อง  

ผู้ศึกษาเลือกพัฒนาโปรแกรมโดยใช้ชุดค าสั่ง VBA บน AutoCAD  และ Microsoft Excel 
(ใช้งานกันอย่างแพร่หลายในวงการวิศวกรรม ผู้ใช้ส่วนใหญ่มีทักษะพื้นฐานการใช้งานอยู่บ้างแล้ว  
และเปิดโอกาสให้ผู้มีความสนใจพัฒนาโปรแกรม) ให้มีคุณลักษณะที่ใช้งานได้โดยง่ายและคุ้นเคย
เหมือนขั้นตอนการท างานวิเคราะห์  ออกแบบและเขียนแบบก่อสร้างปกติทั่วไป โดยใช้ข้อมูลจาก
การเขียนแปลนน าเข้าข้อมูลในรูปแบบกราฟิกและป้อนตัวเลข เพื่อใช้วิเคราะห์ค านวณโครงสร้าง
คานโดยวิธี Moment Distribution จากนั้นก็ด าเนินการออกแบบโครงสร้างพื้น-คานคอนกรีตเสริม
เหล็กด้วยวิธีหน่วยแรงใช้งาน(WSD) เมื่อได้ปริมาณเหล็กเสริมพร้อมทั้งหน้าตัดพื้น-คานคอนกรีต
เสริมเหล็กที่เหมาะสม  ก็จะน ามาแสดงและเขียนแบบได้โดยอัตโนมัตบิน AutoCAD    

  
 

 
 

 
 
 
 

รูปที่  3.2   AutoCAD  Release  History   
 

 
 
 
 
 

 

 
 

รูปที่  3.3   Microsoft  Excel  Release  History  
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ปรับปรุงแก้ไขส่วนท่ีบกพร่อง 

 

ถูกต้อง 

แผนผังกำรพัฒนำโปรแกรม  
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

            

 

 

 

 

สรุปผลการศึกษาและจัดท าคู่มือ 

 

ตรวจสอบความถูกต้อง/บกพร่อง 

การแสดงผลทางหน้าจอ

คอมพิวเตอร์,เครื่องพิมพ์ 
การน าเข้าข้อมูลทาง

กราฟิกและตัวเลข 

ผลการค านวณวิเคราะห์ 

ออกแบบและเขียนแบบ 

ส ารวจปัญหาของการท างานวิเคราะห์ ออกแบบ

และเขียนแบบโครงสร้างพื้น-คาน คสล. 

รวบรวมข้อมูล 

ศึกษางานวิจัยที่เกี่ยวข้องกับ 

การพัฒนาโปรแกรม ฯ 

อ อ ก แบ บ  UGI ให้ น า เข้ าข้ อ มู ล

สัมพันธ์กับการจัดเก็บ การวิเคราะห์

ออกแบบ,เขียนแบบ และการแสดงผล 

พัฒนาโปรแกรม ฯ 

ทดสอบโปรแกรม ฯ 

ศึกษา  VBA บน  

AutoCAD, Excel 

ศึกษาการวิเคราะห์ ออกแบบ

และเขียนแบบพื้น-คาน คสล. 

 

ส่วนแสดงผล 

 

ส่วนน าเข้า

ข้อมูล 

ส่วนวิเคราะห ์ ส่วนออกแบบ 

 

ส่วนเขียนแบบ 
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3.3  กำรสร้ำงชุดค ำสั่ง VBA                                   
เป็นขั้นตอนที่ผู้ศึกษาต้องด าเนินการสร้างชุดค าส่ง VBA ด้วยตนเอง ในส่วนการน าเข้า

ข้อมูล ส่วนค านวณ ส่วนเชื่อมโยงข้อมูลโครงการ และส่วนแสดงผล บน AutoCAD และ Excel
เปรียบเทียบผลลัพธ์ที่ได้ขณะสร้างชุดค าสั่ง โดยท าการป้อนข้อมูลโดยใช้แบบมาตรฐานบ้านเพื่อ
ประชาชน พ.ศ.2559  ของกรมโยธาธิการและผังเมืองกระทรวงมหาดไทย จ านวน 2 แบบ  เพื่อใช้
ในการค านวณวิเคราะห์ ออกแบบและเขียนแบบโครงสร้างพื้น -คานคอนกรีตเสริมเหล็ก  ด้วย
โปรแกรม  ควบคู่กับการค านวณด้วยมือและวิธีการท างานปกติ   

 

 

 

 

 

 

 
 

รูปที่ 3.4  สร้างชุดค าสั่งบน VBA Editor  ใน  AutoCAD 
 

 

 

 

 

 
 

รูปที่ 3.5  สร้างชุดค าสั่ง  Form  เพื่อรับข้อมูลในโปรแกรม  AutoCAD  
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รูปที่ 3.6 สร้างชุดค าสั่ง VBA บน AutoCAD ให้ท าการถ่ายหนักบรรทุก 

 

 

รูปที่ 3.7 สร้างชุดค าสั่ง VBA บน Excel ให้ท าการวิเคราะห์โครงสร้าง 
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รูปที่ 3.8  สร้างข้อความแจ้งสิทธิ์การใช้งานโปรแกรม 
 

 

 
 

รูปที่ 3.9  สร้างเมนูบาร์ชื่อ A2D RC บน AutoCAD  
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รูปที่ 3.10  สร้างส่วนแจ้งเตือนที่เกี่ยวข้องกับการใช้งานโปรแกรม  
 

 

 

 

 

 

 

 

 

 

รูปที่ 3.11 สร้างส่วนแจ้งเตือนที่เกี่ยวข้องกับการใช้งานโปรแกรม 
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รูปที่ 3.12  สร้างปุ่ม Files เพื่อเปิดไฟล์งานเก่าหรือตั้งชือ่งานใหม่ 
 

  

 
 

รูปที่ 3.13  สร้างปุ่ม Project เพื่อจัดเก็บข้อมูลต่างโครงการ 
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รูปที่ 3.14  สร้างการเชื่อมโยงข้อมูลโครงการ ด้วย VBA จาก AutoCAD ไป Excel  
 

3.4  กำรทดสอบโปรแกรมที่พัฒนำขึ้น  
เมื่อท าการสร้างชุดค าสั่ง VBA บน Editor  ของ AutoCAD  และ Microsoft Excel เสร็จสิ้น

แล้ว ต้องท าการทดสอบการท างานของโปรแกรมว่าสามารถน าเข้าข้อมูล  สามารถวิเคราะห์ 
ออกแบบและเขียนแบบโครงสร้างพื้น-คานคอนกรีตเสริมเหล็ก พร้อมทั้งแสดงผลลัพธ์ทาง
จอคอมพิวเตอร์และเคร่ืองพิมพ์  ได้หรือไม่  โดยท าการทดสอบส่วนต่าง ๆ ของโปรแกรม  แบ่ง
ออกเป็น  4  ส่วน หลักๆ ได้แก่ 

1.  ทดสอบการน าเข้าข้อมูลทางกราฟิกและตัวเลข  
เป็นส่วนที่ผู้ใช้โปรแกรมฯ ป้อนข้อมูลรายละเอียดที่จ าเป็น โดยศึกษาจากแบบตัวอย่าง

ที่ได้ก าหนดไว้ทางด้านสถาปัตย์และวิศวกรรมโครงสร้าง  เพื่อไม่ให้สับสนและใช้งานได้ง่าย  จึง
จัดเก็บข้อมูลผ่านไดอะล็อกบล็อก (Graphic  User  Interface ; GUI) เพื่อน าข้อมูลที่ได้จัดเก็บลงใน
แผ่นงานชื่อ Project ใน  Microsoft Excel (work sheet data) ได้แก่   ชื่อโครงการ  จ านวนชั้นที่
ออกแบบ  ความสูงของอาคาร ซึ่งในส่วนนี้จะมีการเชื่อมโยงข้อมูลที่รับเข้ามาในโปรแกรมฯ  
น าไปสู่การค านวณและแสดงผลลัพธ์ ในการพัฒนาโปรแกรมฯ ไดอ้อกแบบให้ผู้ใช้งานป้อนข้อมูล
น้อยที่สุดเท่าที่เป็นไปได้  โดยการเลือกใช้ข้อมูลเท่ากับความต้องการในการค านวณ  แล้วส่งความ
เชื่อมโยงไปสู่การเก็บข้อมูล  การค านวณข้อมูลและแสดงผลให้ครบถ้วนที่สุด 

2.   ทดสอบส่วนเก็บข้อมูลและค านวณวิเคราะห์ ออกแบบและเขียนแบบ  
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2.1 ส่วนจัดเก็บข้อมูลรายละเอียดต่าง ๆ   เป็นฐานข้อมูลที่จ าเป็นต้องใช้ในการค านวณ  
เช่น  พารามิเตอร์ในการออกแบบ  น้ าหนักบรรทุกตาม  พ.ร.บ ควบคุมอาคาร โดย
แยกเป็นแผ่นงาน เช่น แผ่นงานโครงการ Project แผ่นงานพารามิเตอร์  แผ่นงาน
พื้น   แผ่นงานคานใน Microsoft Excel work sheet data   โดยแต่ละแผ่นงานส่วน
เก็บข้อมูลนี้จะใช้มาโคร (Macro)  และ VBA  ท าการเชื่อมโยงกับส่วนรับข้อมูล  
ส่วนค านวณข้อมูล  ส่วนแสดงผล  

2.2  ส่วนค านวณวิเคราะห์ออกแบบโครงสร้างพื้น-คาน คอนกรีตเสริมเหล็ก ถือว่าเป็น
ส่วนที่ส าคัญที่สุดของโปรแกรม ฯ  เน่ืองจากจะท าหน้าที่รับข้อมูลที่ป้อนจากส่วน
ป้อนข้อมูล  เพื่อน าไปอ้างอิงกับส่วนเก็บข้อมูล   แล้วจึงท าการประมวลผล  
จากนั้นจะส่งผลไปแสดงค่าในส่วนแสดงผล  ในขั้นตอนนี้จะท าการสร้างสูตรใน
การค านวณข้อมูลเรียกใช้ฟังก์ชัน(Function)  การก าหนดมาโคร (Macro) และการ
ใช้  Visual Basic Application (VBA) ที่มีอยู่ใน AutoCAD และ Microsoft Excel 
ออกมาใช้งาน  เพื่อใช้ในการค านวณและน าไปสู่การแสดงผลในรูปแบบต่างๆ  ซึ่ง
สูตรค านวณเหล่านี้จะอยู่ภายในแผ่นงาน   ส่วนป้อนข้อมูล  แผ่นงานเก็บข้อมูล
และแผ่นงานแสดงผล  โดยจะตั้งค่าการป้องกันเซลล์ที่ป้อนสูตรค านวณไว้ไม่ให้
ผู้ใช้แก้ไขได้  เพื่อป้องกันการกรอกข้อมูลผิดพลาด 

2.3 ส่วนการเขียนแบบโครงสร้างพื้น-คาน คอนกรีตเสริมเหล็ก เป็นขั้นตอนที่ต้อง
ทดสอบหาข้อผิดพลาดน ามาปรับปรุงพัฒนาโปรแกรม โดยหลังจากที่ได้น าเข้า
ข้อมูล และประมวลผลการวิเคราะห์ออกแบบโครงสร้าง พื้น-คาน ค.ส.ล. แล้ว
เสร็จ มาด าเนินการสร้างแบบแปลน สร้างรูปตัดขยาย 

3.   ทดสอบส่วนแสดงผลทางหน้าจอคอมพิวเตอร์และเคร่ืองพิมพ์  
เป็นส่วนที่แสดงผลในล าดับขั้นตอนสุดท้ายของโปรแกรม  จะท าการแสดงผลลัพธ์

ของการค านวณวิเคราะห์โครงสร้าง  การออกแบบคานคอนกรีตเสริมเหล็ก  แสดงแบบทาง
วิศวกรรมโครงสร้าง  รวมถึงรายละเอียดประกอบแบบก่อสร้าง  สามารถแสดงผลลัพธ์และดู
รายละเอียดทางจอภาพ  เมื่อจะน าไปใช้งานก็ เพียงสั่ งพิมพ์ผ่านเคร่ืองพิมพ์ที่ เชื่อมต่อกับ
คอมพิวเตอร์ของผู้ใช้งาน 

4.   ตรวจสอบความถูกต้องและแก้ไขจุดบกพร่อง 
เมื่อด าเนินการพัฒนาโปรแกรมฯ  เสร็จสิ้นแล้วจะท าการทดสอบการใช้งานว่ามี

จุดบกพร่องหรือข้อผิดพลาดหรือไม่  โดยจะต้องด าเนินการดังต่อไปนี้ 
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4.1 ใช้แบบมาตรฐานบ้านเพื่อประชาชน พ.ศ.2559  ของกรมโยธาธิการและผังเมือง  
กระทรวงมหาดไทย  จ านวน 2  แบบ เพื่อใช้เป็นข้อมูลน าเข้าและตรวจสอบ
เปรียบเทียบผลลัพท์ที่ได้กับการค านวณด้วยมือ  

4.2  กรณี พบข้อผิดพลาด  (Error and Bug) ต้องด าเนินการย้อนกลับไปแก้ ไข
ข้อบกพร่องตามผังขั้นตอนการพัฒนาโปรแกรม    

4.3  กรณีโปรแกรมแล้วเสร็จสมบูรณ์  ไม่พบข้อผิดพลาด  ให้ด าเนินการสรุปการศึกษา
และข้อเสนอแนะพร้อมจัดท าคู่มือการใช้งาน 

 

3.5 จัดท ำคู่มือกำรใช้งำนโปรแกรม 
การจัดท าคู่มือการใช้งานโปรแกรมเป็นสิ่งส าคัญอย่างหนึ่งของโปรแกรม   เนื่องจากไม่ว่า

โปรแกรมจะท างานได้ดีเพียงใด  แต่หากผู้ใช้ไม่เข้าใจขั้นตอนการใช้งานก็ไม่สามารถน าไปสู่
ผลสัมฤทธิ์ที่ตั้งไว้  คู่มือการใช้งานของโปรแกรมคอมพิวเตอร์วิเคราะห์  ออกแบบและเขียนแบบ
โครงสร้างพื้น - คานคอนกรีตเสริมเหล็ก  โดยจะจัดท าเป็นรูปเล่มแสดงเป็นภาพสี  เพื่อให้สะดวก
ในการใช้งานและมีรูปแบบที่เป็นไฟล์เอกสารบันทึกลงในแผ่นซีดีรอม  สามารถใช้คอมพิวเตอร์ใน
การเปิดอ่านได้  มีแนวทางในการจัดท า  ดังนี ้

1.   บรรยายขั้นตอนให้ผู้ใช้ด าเนินการได้จนบรรลุวัตถุประสงค์ของการใช้งาน 
2.   เน้ือหาในคู่มือการใช้งาน จะประกอบด้วยขั้นตอนการท างานของโปรแกรม 
3.   มีการแนะน าการป้อนข้อมูลที่จ าเป็นต่างๆอย่างชัดเจน  
4.   มีการอธิบายถึงข้อผิดพลาดที่อาจเกิดจากการป้อนข้อมูลไม่ถูกต้อง 
5.  แสดงตัวอย่างการป้อนข้อมูลจากแบบที่ใช้ในการศึกษาพัฒนาโปรแกรม           
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บทที่ 4 
ผลกำรศึกษำและวิเครำะห์ข้อมูล 

 
4.1  กำรติดตั้งโปรแกรม  

ก่อนท าการศึกษาและวิเคราะห์ข้อมูลต้องติดต้ังโปแกรมที่พัฒนาขึ้นเสียก่อน โดยมีขั้นตอน
ดังต่อไปนี้  

1.  ท าการ  Copy Folder  “A2D” และ “A2DF ” น าไปไว้ที่  Drive C:\ 
2. ท าการบอกเส้นทางการเรียกใช้  Files เข้าที่ โปรแกรม AutoCAD เลือกที่  Menu 

bar>Tools>Options> ที่ Tab Files ให้เลือก Support Files Search Path> Click เลือกปุ่ม 
Add> Click เลือกปุ่ม Browe จากนั้นให้เลือกเส้นทางติดต้ังโปรแกรม ดังแสดงในรูปที่ 
4.1 

 

 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่  4.1  เส้นทางการเรียกใช้ Files โปรแกรม A2D RC  ใน AutoCAD 
 
C:\A2D  C:\A2D\  HATCH 
C:\A2D \ Block C:\A2D\  ICON 
C:\A2D\ FONT C:\A2DF 

    เมื่อติดต้ังจนครบแล้ว ให้ Click เลือกปุ่ม OK 
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3.  ติดตั้งโปรแกรม โดยเข้าที่โปรแกรม AutoCAD  เลือกที่ Menu bar>Load Application> 
>  ที่ Tab Load/Un Load  ให้ Click เลือกปุ่ม Contets> Click  เลือกปุ่ม Add> ให้เลือก
ไปยังต าแหน่งที่ตั้ง C:\A2D\ ให้เลือก A2D.DVB   แล้วกดปุ่ม Add> กดปุ่ม Close>  จะ
ปรากฏ Files A2D.dvb  ใน dialogbox>  ที่  Tab Load/Un Load   ให้  Click เลือกปุ่ม 
Close  จากนั้นก็ปิดโปแกรม AutoCAD  ดังแสดงในรูปที่  4.2 (ขั้นตอนการติดตั้ง
โปรแกรมโดยละเอียด สามารถศึกษาได้จากบทที่ 1  คู่มือการใช้งานโปรแกรม A2D  
RC  ในภาคผนวก ก)   

 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 4.2  การติดตั้งโปรแกรม A2D  RC   
 

4.  เมื่อเปิด AutoCAD ใหม่อีกคร้ัง จะพบกับ Dialog ถามความน่าเชื่อถือของชุดค าสั่ง 
VBA Macro ให้เลือกเคร่ืองหมายถูกออกจาก Check box Always ask before opening 
project with macro. > เลือกปุ่ม  Enable Macros > จะปรากฏ Dialog และMenu bar 
“A2D RC” กดปุ่ม OK จะปรากฏดังแสดงในรูปที่ 4.3 และ รูปที่ 4.4 ตามล าดับ 

 
 
 

 

 
รูปที่ 4.3 Dialog A2D RC  
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รูปที่ 4.4 เมนูบาร์โปรแกรม  A2D RC บนAutoCAD 
 

4.2  กำรตั้งสภำพแวดล้อม และกำรเรียกใช้งำน A2D RC 
ก่อนที่จะเร่ิมต้นการใช้งาน A2D RC จ าเป็นอย่างยิ่ง ที่ต้องเตรียมความพร้อมในการ

ก าหนดค่าสภาพแวดล้อมในการท างานของโปรแกรมบน AutoCAD และ Microsoft Excel ให้มี
ความเหมาะสม เพื่อลดปัญหาข้อผิดพลาดในขณะใช้งาน 

โปรแกรม AutoCAD  และ Microsoft Excel อาจจะมองว่าชุดค าสั่ง VBA ของ A2D RC 
เป็นอันตราย จ าเป็นอย่างยิ่งที่ต้องก าหนดค่ายอมรับความปลอดภัยของ Macro ให้เหมาะสม  มี
ขั้นตอนดังน้ี 

4.2.1 AutoCAD Macro 
VBA Macros ของ AutoCAD เตือนให้ก าหนดค่ าความปลอดภัย ให้ เลือก เอา

เคร่ืองหมายถูกออกจาก        Always ask before opening project with macro  แล้วเลือก  Enable 
Macros 

 
 
 
 
 
 
 

รูปที่  4.5  Security Macro บน AutoCAD 
 
 
 
 
 
 
 

รูปที่  4.6  Enable Macro บน AutoCAD  
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4.2.2   Microsoft Excel Macro 
ส าหรับ Excel 2007  ต้องตั้งค่าความปลอดภัย (Trust Center)  มีขั้นตอนดังนี้ 
1.  ไปที่เมนู (Menu) และกดเลือกตัวเลือก Excel (Excel Options) 
 

 
 

รูปที่  4.7  เลือก Excel Options 
 

2.  หลังจากกดเลือก ตัวเลือก Excel (Excel Options) จะแสดงหน้าจอดังนี ้ และ
เลือกศูนย์ความเชื่อถือ (Trust Center) 

 

 
 
 
 
 
 
 
 
 

 
 

 

รูปที่  4.8  เลือก Trust Center 
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3.  กดเลือก ศูนย์ความเชื่อถือ (Trust Center) จะแสดงหน้าจอดังนี้ กดเลือกการตั้ง
ค่าศูนย์ความเชื่อถือ (Trust Center Settings) 

 

 
 
 

. 
 
 
 
 
 
 
 

รูปที่  4.9  เลือก Trust Center Settings  
 

4.   กดเลือก การต้ังค่าศูนย์ความเชื่อถือ (Trust Center Settings) จะแสดงภาพดังนี้ 
กดเลือก การต้ังค่า มาโคร (Macro Settings) 

 
 
 
 
 
 
 

 
 

รูปที่  4.10  เลือก Macro Setting 
 

5.   การตั้งค่ามาโคร (Macro Settings) โดยกดเลือก        เชื่อถือการเข้าถึงรูปแบบ
วัตถุของโครงการ VBA (Trust access to VBA project object model) และกดตก
ลง (OK) 
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                   รูปที่  4.11 การตั้งค่ามาโคร (Macro Settings) 

 
6.   หลังจากติดตั้งตามที่กล่าวมาเรียบร้อยแล้ว   สามารถติดตั้งและเปิดใช้งาน   

Macro บน  Microsoft  Excel   ได้ 
 

4.3  เปิด-ปิดกำรใช้งำน A2D RC  
เมื่อได้ติดตั้งโปรแกรมและก าหนดตั้งค่าสภาพแวดล้อมในการท างานของ A2D  RC บน 

AutoCAD และ Microsoft Excel ให้มีความเหมาะสมแล้ว ขั้นตอนต่อไปคือการทดลองใช้งาน โดย
การเปิดและปิดโปรแกรมสามารถท าได้ผ่ านไอคอนหรือเมนูบาร์ ( ขั้นตอนการการตั้ ง
สภาพแวดล้อมและการเรียกใช้งาน A2D RC โดยละเอียด สามารถศึกษาได้จากบทที่ 2 คู่มือการใช้
งานโปรแกรม A2D  RC  ในภาคผนวก ก)  

  
 

 
 
 

 

รูปที่  4.12 ไอคอนเปิด-ปิด A2D RC   
 
4.4   กำรจัดกำรข้อมูล    

เมื่อโปรแกรมที่ถูกพัฒนาขึ้นได้ถูกติดตั้งแล้วเสร็จ  จากนั้นก็คือขั้นตอนการใช้งานโดยที่
โปรแกรมได้จัดให้มีส่วนโต้ตอบกับผู้ใช้งาน  น าเข้าข้อมูลจากการเขียนแบบแปลนอาคาร ใน
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รูปแบบของกราฟิกและตัวเลข  โดยสามารถอธิบายล าดับขั้นตอนได้ดังต่อไปนี้ 
4.4.1 เปิดโปรแกรม AutoCAD > เมนูบาร์ “A2D RC ” > Slab – Beam  ก็จะปรากฏ “A2D 

RC” บนจอภาพทางด้านซ้าย 
 

 

 
 

 

 

 

 

 
 

 
รูปที่ 4.13 เมนูหลัก A2D RC  

 

4.4.2  การเปิดไฟล์ของงานที่เคยถูกบันทึก Click ที่ปุ่มแรกเลือกที่ค าสั่ง Files จะปรากฏ 
เมนูย่อย “Open Files” อยู่ทางด้านตรงกลางของจอภาพ เพื่อเลือกระหว่างการเปิด
งานเก่าที่ถูกจัดเก็บข้อมูลไว้  หรือสร้างงานขึ้นมาใหม่ 
 

 
 
 

 
                                     รูปที่  4.14  ฟอร์ม Open Files 
 
 

 
 
 
            รูปที่ 4.15   List  Menu  ชื่องานที่ถูกจดัเก็บ         รูปที่ 4.16   เลือกเปิดไฟล์งาน  TEST01 



69 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่ 4.17   ปรากฏชื่องาน “TEST01” และข้อมูลที่ถูกบันทึกไว้   
 

4.4.3 การสร้างไฟล์งานขึ้นมาใหม่ กรณีสร้างงานโครงการใหม่ ให้ตั้งชื่อแล้วกดปุ่ม New 
Model จะปรากฏ  ชื่องานโครงการ  “DCTP06”   พร้อมพื้นที่ท างาน  (รายละเอียด
เพิ่มเติม ของการจัดการและการป้อนข้อมูล  สามารถศึกษาได้จากบทที่ 3 และ บทที่ 
4  คู่มือการใช้งานโปรแกรม A2D RC  ในภาคผนวก ก) 
 

 
 

 

 
                                                  รูปที่ 4.18  ป้อนชื่องานใหม่ในช่องรับข้อมูล 
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รูปที่ 4.19  ชื่อไฟล์และพื้นที่ท างานถูกสร้างขึ้นใหม่ 
 

4.4.4  การควบคุม เปิด - ปิด มุมมอง และการน าเข้าข้อมูล ผ่านการใช้ค าสั่งไอคอนเมนูทูล
บาร์บนฟอร์ม,เมนูหลักและย่อย 

 

     

 
    
 

 

 

 

 

 

 

4.4.5  การป้อนข้อมูลที่ได้จาการอ่านแบบแปลนก่อสร้าง  อ้างอิงจากแบบมาตรฐานบ้าน
เพื่อประชาชน  พ.ศ.2559  ของกรมโยธาธิการและผังเมือง  กระทรวงมหาดไทย 
จ านวน 2  แบบ มีขั้นตอนดังน้ี 

4.4.5.1  สร้างไฟล์งานขึ้นมาใหม่  
4.4.5.2  ป้อนข้อมูลโครงการ 
4.4.2.3  ร่างแบบ 

ก.  ก าหนดประเภทอาคาร 

Regeneration Layer  
 

Input Data : การน าเข้าข้อมูล 

Return : การกลับสู่เมนูหลัก 

Pan : การเลื่อนหน้าจอ พื้นที่ท างาน 
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ข.  ก าหนด Gride  และ  Dimension 
ค.  สร้างเส้นร่าง (Guide Line)   
ง.  ก าหนดชั้นของอาคาร   
จ.  ป้อนข้อมูล Column 
ฉ.  ป้อนข้อมูล Beam 
ช.  ป้อนข้อมูล Slab 
ซ.  ป้อนข้อมูล Wall   
ฌ.  คัดลอกข้อมูลเสา, คาน, พื้น และผนัง 
ญ.  ป้อนข้อมูล Roof 

 
4.5  กำรวิเครำะห์ ออกแบบและเขียนแบบโครงสร้ำงพื้น ค.ส.ล. 

เป็นขั้นตอนที่ส าคัญในการน าเอาข้อมูลที่ได้จากการร่างแบบและข้อมูลคุณสมบัติของ วัสดุ
ที่ได้ด าเนินการและจัดเก็บข้อมูลใน Microsoft Excel ท าการวิเคราะห์ออกแบบ (พื้น 2 ทางใช้วิธีที่ 2 
ว.ส.ท.9102 )และเขียนแบบ โดยมีขั้นตอนดังต่อไปนี้  (ขั้นตอนการใช้งานโปรแกรมจะกล่าว
โดยสังเขป  รายละเอียดสามารถศึกษาได้จากบทที่ 5 และ บทที่ 6 คู่มือการใช้งานโปรแกรม A2D 
RC ในภาคผนวก ก) 

4.5.1 ก าหนดคุณสมบัติของวัสดุ 
4.5.1.1 เลือกก าลังอัดประลัยของคอนกรีต 
4.5.1.2  เลือกชั้นคุณสมบัตแิละแรงดึงประลัยของเหล็กเสริมคอนกรีต 
4.5.1.3  จัดเก็บข้อมูล 

4.5.2  วิเคราะห์ ออกแบบและเขียนแบบโครงสร้างพื้น ค.ส.ล. 
4.5.2.1  แก้ไขน้ าหนักบรรทุก (LL) และ Super imposed Dead Load (SDL) 
4.5.2.2  วิเคราะห์ ออกแบบและเขียนแบบพื้น ค.ส.ล. 

ก.  ก าหนดพื้นความหนาของแผ่นพื้นและวิเคราะห์ออกแบบ 
ข.  แสดงผลในแบบกราฟิก และตารางค านวณ (ปริมาณเหล็กเสริมและ

หน้าตัดพื้น) ตารางค านวณ 
ค.  เขียนแบบขยายพื้น ค.ส.ล. 
ง.  เปลี่ยนชื่อพื้นในแบบแปลน 
จ.  สร้างแบบแปลนพื้น 
ฉ.  สร้างแบบขยายพื้น 
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4.6  กำรถ่ำยน้ ำหนักบรรทุกจำกหลังคำ 

ก่อนจะมีการวิเคราะห์ และออกแบบคาน ค.ส.ล. รับน ้าหนักบรรทุกทางโครงหลังคา 
(จันทันพราง) จ าเป็นจะต้องมีการค านวณเพื่อ คิดถ่ายน้ าหนักบรรทุกเสียก่อน A2S RC มีฟังก์ชันที่
ช่วยงานดังกล่าว โดยท าการเลือกค าสั่ง Roof เพื่อเข้าสู่เมนู Design roof กดปุ่ม Listbox เลือกชื่อ
หลังคาที่เคยถูกตั้งเอาไว้แล้วในขั้นตอนการร่างแบบชั้น Roof กดปุ่ม Load Transform 

 
 
 
 
 
 
 
 
 
 
 

รูปที่ 4.20  ขั้นตอนการถ่ายน้ าหนักบรรทุกจากหลังคา 
 

4.7  กำรวิเครำะห์ ออกแบบและเขียนแบบโครงสร้ำงคำน ค.ส.ล. 
เป็นขั้นตอนที่ส าคัญในการน าเอาข้อมูลที่ได้จากการร่างแบบและข้อมูลคุณสมบัติของวัสดุ

ที่ได้ด าเนินการและจัดเก็บข้อมูลใน Microsoft Excel ท าการวิเคราะห์ ออกแบบและเขียนแบบ คาน 
ค.ส.ล. (รายละเอียด สามารถศึกษาได้จากบทที่ 5 และ บทที่ 6  คู่มือการใช้งานโปรแกรมA2D RC 
ในภาคผนวก ก)  

ผู้ใช้งานโปรแกรมต้องท าการวิเคราะห์และออกแบบพื้นคอนกรีตเสริมเหล็กและท าการถ่าย
น้ าหนักจากหลังคาลงสู่คานรับโครงหลังคานให้เสร็จสิ้นเสียก่อน  จึงจะท าการวิเคราะห์และ
ออกแบบคานคอนกรีตเสริมเหล็กได้  โดยมีขั้นตอนดังต่อไปนี้ 

4.7.1  การวิเคราะห์ ออกแบบ 
4.7.1.1  ก าหนดชั้นของอาคาร   
4.7.1.2  ถ่ายน้ าหนักบรรทุกแบบแผ่กระจายเลือก  Load  on  Beam   
4.7.1.3  ก าหนดคานแบบยื่น เลือก  Cantilever   
4.7.1.4  ถ่ายน้ าหนกับรรทุกแบบกระท าเป็นจุด เลือก  Point  Load   
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4.7.1.5  Trial  Section 
4.7.1.6  วิเคราะห์ออกแบบโครงสร้าง 
4.7.1.7  แสดงผลการค านวณวิเคราะห์ ออกแบบโครงสร้าง คาน ค.ส.ล. ในแบบ

กราฟิกและตารางค านวณ (ปริมาณเหล็กเสริมและหน้าตัดคาน) 
4.7.2  การเขียนแบบ และรายละเอียด 

เป็นขั้นตอนสุดท้ายหลังจากที่ได้ท าการวิเคราะห์ออกแบบโครงสร้างคาน ค.ส.ล. 
เป็นที่เรียบร้อยแล้ว (รายละเอียดสามารถศึกษาได้จากบทที่ 5 และ บทที่ 6 คู่มือการใช้งานโปรแกรม 
A2D RC ในภาคผนวก ก)  มีขั้นตอนดังน้ี 

4.7.2.1 เขียนแบบคานแสดง  1  หน้าตัด 
      ก. ตรวจสอบปริมาณเหล็กเสริมในคาน ค.ส.ล. บนคานช่วงเดียว 
      ข. จัดกลุ่มคาน 
      ค. เปลี่ยนชื่อคานในแบบแปลน 

4.7.2.2  การเขียนแบบคาน  แสดง 3 หน้าตัด 
ก.  ตรวจสอบปริมาณเหล็กเสริมในคาน ค.ส.ล. บนคานต่อเน่ือง 
ข.  จัดกลุ่มคาน 
ค.  เปลี่ยนชื่อคานในแบบแปลน 

4.7.2.3  การเขียนภาพตัดทางยางของคาน  ค.ส.ล. แบบต่อเน่ือง 
4.7.2.4  การแก้ไขหน้าตัดคานในแบบ 
4.7.2.5  การสร้างแบบข้อก าหนดทั่วไปทางวิศวกรรมโครงสร้าง 
4.7.2.6  การสร้างแบบแปลนพื้น-คาน ค.ส.ล.  
4.7.2.7  การสร้างแบบขยายโครงสร้างพื้น-คาน ค.ส.ล. 

4.7.3 รายการค านวณโครงสร้างพื้น-คาน ค.ส.ล. 
4.7.3.1  ภาพแรงน้ าหนักบรรทุก (FBD) 
4.7.3.2  ภาพแรงเฉือน (SFD) 
4.7.3.3  ภาพโมเมนต์ดัด (BMD) 
4.7.3.4  จุดและระยะดัดกลับของโมเนต์ (Inflection point) 
4.7.3.5  ตารางค านวณวิเคราะห์ออกแบบพื้น-คาน คส.ล. 
4.7.3.6  หน้าตัดและรายละเอียดปริมาณเหล็กเสริม การจัดวาง 
ผลลัพธ์ที่ได้จากการใช้ A2D RC สามารถศึกษาได้จากบทที่ 5 และ บทที่ 6 คู่มือการ

ใช้งานโปรแกรม A2D RC  ในภาคผนวก ก)  
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บทที ่5 
สรุปและข้อเสนอแนะ 

 
5.1 สรุปผลกำรศึกษำ 

การพัฒนาโปรแกรมวิเคราะห์  ออกแบบและเขียนแบบโครงสร้างพื้น-คานคอนกรีตเสริม
เหล็กในคร้ังนี้  ได้บรรลุตามวัตถุประสงค์ภายใต้ขอบเขตของการศึกษาที่ได้ต้ังไว้  ดังนี้ 

1.  การใช้โปรแกรม ฯ โดยน าเข้าข้อมูลแบบมาตรฐานบ้านเพื่อประชาชน พ.ศ.2559   ของ
กรมโยธาธิการและผังเมือง  กระทรวงมหาดไทย  จ านวน 2  แบบ  ได้ผลลัพธ์คือ
สามารถด าเนินการวิเคราะห์ ออกแบบและเขียนแบบโครงสร้างพื้น-คานคอนกรีตเสริม
เหล็ก ด้วยวิธีหน่วยแรงใช้งาน  ได้อย่างถูกต้องเมื่อเปรียบเทียบกับการค านวณด้วยมือ  

2.  โปรแกรม ฯ สามารถแสดงผลลัพธ์จากการวิเคราะห์โครงสร้าง  ซึ่งประกอบด้วย
น้ าหนักบรรทุก  แผนภาพแรงปฏิกิริยา แผนภาพแรงเฉือน แผนภาพโมเมนต์ดัด แสดง
ระยะที่เป็นจุดดัดกลับของพฤติกรรมคาน  พร้อมทั้งจัดท ารายการค านวณ สามารถ
เขียนแบบแปลน รูปตัดและแสดงรายละเอียดแบบโครงสร้างพื้น-คานคอนกรีตเสริม
เหล็ก  โดยแสดงผลได้ทั้งทางหน้าจอคอมพิวเตอร์และเคร่ืองพิมพ์ 

3.   ได้คู่มือเพื่อช่วยประกอบการเรียนรู้ประยุกต์ใช้งานโปรแกรม ฯ 
 

5.2 อภิปรำยผลกำรศึกษำ 
ผลที่ได้จากการศึกษาคร้ังนี้คือได้โปรแกรม ฯพร้อมคู่มือการใช้งาน ที่สามารถวิเคราะห์

ออกแบบและเขียนแบบโครงสร้างพื้น-คานคอนกรีตเสริมเหล็ก ด้วยวิธีหน่วยแรงใช้งานได้อย่าง
ถูกต้อง  รวดเร็ว  ช่วยประหยัดเวลา  ลดจ านวนบุคลากรผู้ด าเนินการ ลดขั้นตอนการท างานซ้ าๆ  ลด
ข้อผดิพลาดจากการค านวณด้วยมือ  แสดงผลได้ทางหน้าจอคอมพิวเตอร์และเคร่ืองพิมพ์    

 
5.3  ข้อเสนอแนะ 

โปรแกรม ฯ สามารถท าได้ตามวัตถุประสงค์ที่ตั้งไว้  แต่ก็ยังมีข้อจ ากัดดังนี้ 
1. การประมวลผลค านวณวิเคราะห์โครงสร้าง อาจจะเกิดความล่าช้าในกรณีที่มี  Node 

ของโครงสร้างจ านวนมาก เนื่องจาก VBA เป็นภาษาแบบ Interpreter ที่ถูกพัฒนาบน 
Platform เคร่ืองคอมพิวเตอร์แบบ 32 บิต ในการพัฒนาโปรแกรมต่อไป ควรพิจารณา
เลือกใช้ภาษา VB.NET หรือ C#  ซึ่งเป็นภาษาแบบ Compiler 64 บิต สามารถท างาน
ประมวลผลได้เร็วกว่า 
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 2.   การวิเคราะห์โครงสร้างเนื่องจากน้ าหนักบรรทุกที่กระท าแบบกระจายค่อย ๆ แผ่
เพิ่มขึ้นไม่สามารถท าได้ 

3.   การวิเคราะห์โครงสร้างเนื่องจากน้ าหนักบรรทุกที่กระท าเป็นจุด ได้มากสุด 3 จุดต่อ
ช่วงคาน (Span) หากเกินกว่านั้นจะคิดค านวณโดยน า Point load มารวมกันที่ระยะ
กึ่งกลางคาน  

4.   การวิเคราะห์ออกแบบโครงสร้างพื้น-คานคอนกรีตเสริมเหล็กต้านแผ่นดินไหว  ไม่
สามารถท าได้ 

5.   ไม่สามารถวิเคราะห์ออกแบบและเขียนแบบคานคอนกรีตเสริมเหล็กนอกแกน X,Y ได้ 
6.  ขนาดหน้าตัดคานที่ใหญ่ที่สุดที่สามารถวิเคราะห์  ออกแบบและเขียนแบบได้  คือ  

0.40X0.80  เมตร  และโปรแกรมไม่คิดค านวณให้เสารับโมเมนต์จากคาน 
7.   ระดับหลังคานที่แตกต่างกันเกิน 0.20  เมตร โปรแกรมจะไม่คิดค านวณเป็นคาน

ต่อเน่ือง  จะแยกคิดเป็นคานช่วงเดียว (Simple Beam)   
ส าหรับผู้ที่สนใจจะพัฒนาโปรแกรม ฯ สามารถใช้การศึกษาคร้ังนี้  เป็นแนวทางในการ

พัฒนาโปรแกรมส าหรับวิเคราะห์  ออกแบบและเขียนแบบในโครงสร้างคอนกรีตเสริมเหล็กส่วน
อ่ืนๆ ได้ เช่น  บันได  เสา  และฐานราก  
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บทที่  1   
การติดตั้งโปรแกรม A2D  RC 

 
1.1  เครื่องคอมพิวเตอร์และอุปกรณ์ 

1.1.1  คอมพิวเตอร์แบบตั้งโต๊ะหรือพกพา   CPU 2 GHz   ขึ้นไป 
  1.1.2  จอภาพขนาด ไม่ต ่ากว่า 15 นิ้ว   (แนะน่า 17 นิ้ว  จอแบน) 
1.1.3  เมาส์และอุปกรณ์อื นๆ ที จ่าเป็น (แนะน่า optical mouse 3 ปุ่ม) 
1.1.4  ระบบปฏิบัติการ Window XP , VISTA  7 , 8  และ 10  
1.1.5  เครื องพิมพ์ (Printer)   สามารถพิมพ์บนกระดาษขนาด A3  ได้ 

  1.1.6 โปรแกรม  AutoCAD  2007  (AutoCAD ตั้งแต่  Version  2010  ต้องโหลด  VBA   
                        Anable ที เว็บไซด์  ของ  Audesk  มาติดตั้ง) 

 
 
 
 
 

รูปที  1.1  คอมพิวเตอร์ตั้งโต๊ะ และคอมพิวเตอร์แบบพกพา 
 
1.2  ขั้นตอนการติดตั้ง A2D  RC 

1.2.1  ติดตั้ง AutoCAD และ Microsoft Excel เปิดเครื องคอมพิวเตอร์ หลังจากเข้าสู่
ระบบปฏิบัติการแล้ว  ถ้ายังไม่ได้ติดตั้ง AutoCAD  2007  หรือเวอร์ชันที สูงกว่าลง
ในเครื อง ให้ติดตั้งโปรแกรมลงไปก่อน  หลังจากติดตั้งแล้ว ให้ใส่แผ่น CD  ของ  
A2D RC  ลงในเครื อง CD  Drive 

1.2.2  คัดลอกไฟล์ ไปติดตั้งท่ี Drive C:\ 

C:\A2D   C:\A2D\  HATCH 
C:\A2D \ BLOCK C:\A2D\  ICON 
C:\A2D\ FONT  C:\A2DF 

       ติดตั้งครบแล้ว  จึงด่าเนินการในขั้นตอนถัดไป 
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 1.2.3 ก า ห น ด เส้ น ท า ง เ รี ย ก ใ ช้ ง า น  A2D RC บ น  AutoCAD เลื อ ก  Menu  
bar>Tools>Options> ที  Tab Files  ให้เลือก Support Files Search Path> Click  เลือก
ปุ่ ม  Add> Click  เลื อ ก ปุ่ ม  Add  แ ล ะ Browse Path ต่ า แ ห น่ ง ไ ป ที  C:\A2D, 
C:\A2D\BLOCK, C:\A2D\FONT, C:\A2D\HATCH, C:\A2D\ICON และ  C:\A2DF  

 

 

 

 

 

 

 

 

 

รูปที   1.2  เลือก Menu  bar>Tools>Options 

 

 

 

 

 

 

 

รูปที   1.3   เลือก  Add  และ Browse  
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รูปที   1.4  เส้นทางการเรียกใช้งานไฟล์ต่างๆ  

1.2.4  ติ ด ตั้ ง  A2D.dvb  โ ด ย เข้ าที โ ป ร แ ก รม  AutoCAD  เลื อ ก ที  Menubar>Load 
Application> >  ที  Tab Load/Un Load  ให้ Click เลือกปุ่ม Contets> Click  เลือกปุ่ม 
Add> ให้เลือกไปยังต่าแหน่งที ตั้ง C:\A2D\ให้เลือก A2D.DVB แล้วกดปุ่ม Add> กด
ปุ่ม Close> จะปรากฏ Files A2D.dvb ใน dialogbox>  ที  Tab Load/Un Load   ให้ 
Click เลือกปุ่ม Close  จากนั้นก็ปิดโปแกรม AutoCAD   

 
 

 

 

 

 
 

รูปที   1.5  เลือก  Tools>Load  Applications 
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รูปที   1.6  ที  Load /Unload  Applications กดปุ่ม Contents 

 

 

 

 

 

 

 

 

รูปที   1.7   ที  Startup / Suite ให้กดปุ่ม Add 
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รูปที    1.8   Browse  Path C:\A2D\...... 

 

รูปที   1.9 เลือกไฟล์ A2D.dvb 
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รูปที  1.10   A2D.dvb ถูกติดต้ัง  
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บทที่  2   
สภาพแวดล้อมและเรียกใช้งาน A2D  RC 

  
ก่อนที่จะเร่ิมต้นการใช้งาน A2D RC จ าเป็นอย่างยิ่ง ที่ต้องเตรียมความพร้อมในการ

ก าหนดค่าสภาพแวดล้อมในการท างานของโปรแกรมบน AutoCAD และ Microsoft Excel ให้มี
ความเหมาะสม เพื่อลดปัญหาข้อผิดพลาดในขณะใช้งาน 

 

2.1 ตั้งค่าความปลอดภัยของ Macro 
AutoCAD  และ Microsoft Excel อาจจะมองว่าชุดค าสั่ง VBA ของ A2D RC เป็นอันตราย 

จ าเป็นอย่างยิ่งที่ต้องก าหนดค่ายอมรับความปลอดภัยให้เหมาะสม  มีขั้นตอนดังน้ี 
2.1.1  AutoCAD Macro 

     VBA Macros ของ AutoCAD เตือนให้ก าหนดค่ าความปลอดภัย ให้ เลือก เอา
เคร่ืองหมายถูกออกจาก        Always ask before opening project with macro  แล้วเลือก  Enable 
Macros 

 
 
 
 
 
 
 

รูปที่  2.1  Security Macro บน AutoCAD 

 

 

 

 

รูปที่  2.2  Enable Macro บน AutoCAD  
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2.1.2   Microsoft Excel Macro 
ส าหรับ Excel 2007  ต้องตั้งค่าความปลอดภัย (Trust Center)  มีขั้นตอนดังนี้ 
1. ไปที่เมนู (Menu) และกดเลือกตัวเลือก Excel (Excel Options) 
 

 
รูปที่  2.3  เลือก Excel Options 

2.  หลังจากกดเลือก ตัวเลือก Excel (Excel Options) จะแสดงหน้าจอดังนี ้ และเลือก
ศูนย์ความเชื่อถือ (Trust Center) 

 
 
 
 
 
 
 
 
 
 

 
 

รูปที่  2.4  เลือก Trust Center 
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3. กดเลือก ศูนย์ความเชื่อถือ (Trust Center) จะแสดงหน้าจอดังนี้ กดเลือกการตั้งค่า
ศูนย์ความเชื่อถือ (Trust Center Settings) 

 

 

 

. 
 
 
 
 
 
 

รูปที่  2.5  เลือก Trust Center Settings  

4.  กดเลือก การตั้งค่าศูนย์ความเชื่อถือ (Trust Center Settings) จะแสดงภาพดังนี้  
กดเลือก การตั้งค่า มาโคร (Macro Settings) 

 

 
 
 
 
 
 
 
 

รูปที่  2.6  เลือก Macro Setting 
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5.  การต้ังค่ามาโคร (Macro Settings) โดยกดเลือก        เชื่อถือการเข้าถึงรูปแบบวัตถุ
ของโครงการ VBA (Trust access to VBA project object model) และกดตกลง 
(OK) 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
รูปที่  2.7 การตั้งค่ามาโคร (Macro Settings) 

 
6.  หลังจากติดตั้งตามที่กล่าวมาเรียบร้อยแล้ว   สามารถติดตั้งและเปิดใช้งาน   

Macro บน  Microsoft  Excel   ได้ 
  

2.2  เปิด-ปิดการใช้งาน A2D RC  
เมื่อได้ติดตั้งโปรแกรมและก าหนดตั้งค่าสภาพแวดล้อมในการท างานของ A2D  RC บน 

AutoCAD และ Microsoft Excel ให้มีความเหมาะสมแล้ว ขั้นตอนต่อไปคือการทดลองใช้งาน โดย
การเปิดและปิดโปรแกรมสามารถท าได้ผ่านไอคอนหรือเมนูบาร์  

 
 

 
 
 

 
รูปที่  2.8  ไอคอนเปิด-ปิด A2D RC    
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รูปที่  2.9  เปิด A2D RC จะพบข้อความแรก  

 

รูปที่  2.10  ข้อความแจ้งให้สร้างโครงการ 

 

 

รูปที่   2.11 A2D RC ที่เมนูบารข์อง AutoCAD 
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รูปที่  2.12 เลือกเมนูย่อย Slab-Beam เเปิดทูลบาร์ A2D RC 

 

 

 

 

 

 

 

 

รูปที่  2.13 เมนทููลบาร์ A2D RC บริเวณทางซ้าย AutoCAD 
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บทที่  3   
การจัดการข้อมูล 

 

ก่อนที่จะเร่ิมต้นการใช้งาน A2D RC  ในการวิเคราะห์  ออกแบบและเขียนแบบโครงสร้าง
พื้น-คาน  คอนกรีตเสริมเหล็ก  จ าเป็นอย่างยิ่งที่จะต้องศึกษาเรียนรู้การจัดการข้อมูลการท างาน   มี
ขั้นตอนดังต่อไปนี้ 

 

3.1  การเปิดไฟล์ของงานท่ีเคยถูกบันทึก 
 
 
 
 
 
 
 
 
 
 
 
       

 
                                                                         รูปที่  3.2  ฟอร์ม Open Files  
                                                                   
                                                               
 
 
 

 

รูปที่  3.1   Main Menu ของ  A2D  RC 

  

เปิ ด  AutoCAD > Menu bar “A2D RC ” > Slab-Beam  
ก็จะปรากฏไอคอนเมนูทูลบาร์ “A2D RC ” ทางด้าน
ซ้ายมือของจอภาพ  แสดงดังรูป 
 

Click ที่ปุ่มแรกเลือกที่ค าสั่ง Files จะปรากฏ เมนูย่อย 

“Open Files” อยู่ทางด้านตรงกลางของจอภาพ เพื่อเลือก

ระหว่างการเปิดงานเก่าที่ถูกจัดเก็บข้อมูลไว้  หรือสร้าง

งานขึ้นมาใหม่ 

ดังรูป 
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                   รูปที่ 3.3   List  Menu  ชื่องานทีถู่กจัดเก็บ                 รูปที่ 3.4   เลือกเปิดไฟล์งาน  

TEST01 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.5   ปรากฏชื่องาน “TEST01” และข้อมูลที่ถูกบันทึกไว้   
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3.2  การสร้างไฟล์งานขึ้นมาใหม ่
        กรณีสร้างงานโครงการใหม่ ให้ตั้งชื่อแล้วกดปุ่ม New Model จะปรากฏ  ชื่องานโครงการ  
“DCTP06”   พร้อมพื้นที่ท างาน 

 

 

 

                                                  รูปที่ 3.6  ป้อนชื่องานใหม่ในช่องรับข้อมูล 

 

 

 

 

 

 

รูปที่ 3.7  ชื่อไฟล์และพื้นที่ท างานถูกสร้างขึ้นใหม่ 

3.3   การควบคุม เปิด - ปิด มุมมอง และการน าเข้าข้อมูล  

 

     

 
   
 

รูปที่ 3.8   ไอคอนเมนูทูลบาร์บนฟอร์ม,เมนูหลักและย่อย 

Regeneration  
Layer ของ AutoCAD 

Input Data 
การน าเข้าข้อมูล 

Return 
การกลับสู่เมนูหลัก 

Pan 
การเลื่อนหน้าจอ พื้นที่ท างาน 
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บทที่  4   
การน าเข้าข้อมูล 

 
โปรแกรมมี  GUI  คือส่วนโต้ตอบกับผู้ใช้งาน  เพื่อน าเข้าข้อมูลจากการเขียนแบบแปลน

อาคาร  ในรูปแบบของกราฟิกเป็นส่วนมาก  มีส่วนน้อยที่เป็นการน าเข้าข้อมูลเป็นข้อความและ
ตัวเลข มีขั้นตอนดังต่อไปนี้ 
 
4.1. โครงการ 

4.1.1 เปิด  AutoCAD > Menu bar “A2D RC ” > Slab-Beam ก็จะปรากฏ “A2D RC ” 

ทางด้านซ้ายมือของจอภาพ  ที่เมนูหลัก A2D RC กดปุ่ม  File ตั้งชื่อ  กด New Model 

กดปุ่ม Return กลับสู่ A2D RC 

 
 
 
 
 
 
 
 

 

 

 

รูปที่ 4.1  A2D RC  และพื้นที่ท างานบน AutoCAD 

โปรแกรมมีส่วนที่ช่วยแนะน าขั้นตอนการท างาน โดยข้อความจะปรากฏ เป็นล าดับ 

(1)... (2)... (3)... (4).... เมื่อน า mouse ไปวางบนต าแหน่งไอคอนทูลบาร ์
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รูปที่ 4.2  ตั้งชื่อโครงการใหม่ “DPT02” 

4.1.2 ป้อนข้อมูลโครงการท่ี  A2D RC กดปุ่ม   Project  จะปรากฏแบบฟอร์ม Model  
Project   Initialzation   เพื่อป้อนข้อมูลของโครงการและจ านวนชั้นลงไปในช่องว่าง 
เช่น   Project    Name…..ให้ครบแล้ว กดปุ่ม  Story Height4 ที่ฟอร์ม Floor level 
ป้อนข้อมูลความสูงของแต่ละชั้น  กดปุ่ม Calculate แล้ว กด Input ข้อมูลของ
โครงการจากการป้อนบน AutoCAD  ได้น ามาจัดเก็บไว้ที่ Excel ให้ตรวจสอบความ
ถู ก ต้ อ ง อี กค ร้ั ง  แล้ ว กดปุ่ ม  Close-Save เพื่ อ ก ลั บ สู่ เม นู ย่ อ ย  Model Project   
Initialzation ให้กดปุ่ม  Regenerate เพื่ อปรับเตรียมเลเยอร์และข้อมูลให้พร้อม
ด าเนินการขั้นต่อไป 

 

 

 

 

 

 

 

 

รูปที่  4.3  กดปุ่ม Story Height 
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รูปที่  4.4  กดปุ่ม Calculate แล้ว กด Input ข้อมูล 

 

 

 

 

 

 

 

 

รูปที่  4.5  ที่ Excel ตรวจสอบข้อมูล กดปุ่ม Close-Save 

 

  



19 
 

4.2   ร่างแบบ 
การร่างแบบเป็นขั้นตอนที่ส าคัญในการน าเข้าข้อมูลโครงการ โดยเร่ิมจากการเลือกค าสั่ง  

Drafting   บนเมนูหลักของ  A2D  RC  จะปรากฏเมนูแบบร่าง ดังรูป 
 

 

 

 

 

 

 

 

 

รูปที่ 4.6  เมนู Drafting พร้อมพื้นที่ท างาน 

4.2.1 ก าหนดประเภทอาคาร 
  ที่ เมนูหลัก Drafting จะมี List box อาคารแต่ละประเภท ซึ่งมีน้ าหนักบรรทุกจร 

(Live Load;LL)  ตาม พ.ร.บ.ควบคุมอาคาร พ.ศ.2522  ให้เลือกดังรูป 
 
 
 
 
 
        

     รูปที่  4.7   List box อาคารแต่ละประเภท         รูปที่ 4.8  อาคารบ้านพักอาศัยได้ถูกเลือก   
                                                                                              พร้อมน้ าหนักบรรทุกจร  
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4.2.2   ก าหนด Gride  และ  Dimension  
                        4.2.2.1 กดปุ่ม Define เพื่อน าเข้าข้อมูล  Gride line  บนแบบแปลน  โดยด าเนินการ

ป้อนข้อมูล Gride  line  และระยะระหว่าง Gride (span)  โปรแกรมจะสร้าง  
Node เสาพร้อมทั้ง Gride Name และ Dimension โดยอัตโนมัติ  หากไม่
ต้องการ กดปุ่ม Delete เพื่อลบ Grid line 

 
 
 

 

 
 
 

รูปที่  4.9  From น าเข้าข้อมูล Gride line ระนาบ  X-Y  

 

 

 

 

รูปที่ 4.10   ป้อนข้อมูลจ านวนของ  Gride line X-Y แล้วกดปุ่ม Span 

 

 

 

 

 

รูปที่  4.11  ป้อนข้อมูลระยะ Span ในระนาบ X-Y 
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                                                           รูปที่  4.12  กดปุ่ม Draw 

 

 

 

 

 

 

 

 
 

รูปที่  4.13  Gride line ถูกสร้างขึ้น กดปุ่ม Return กลับสู่เมนู Drafting 
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รูปที่  4.14  กดปุ่ม Delete เพื่อลบ Grid line 

 

 

 

 

 
 

รูปที่  4.15 กดปุ่ม Dimension ปรากฏระยะ  Gride line , Nod เสา ,  Gride name  อัตโนมัติ 
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4.2.2.2 กรณีก าหนด  Node  เสาเอง โดยคลิกที่ปุ่ม  Node Column  เมื่อปรากฎ
ข้อความ Select  Point ให้เลือกที่ต าแหน่งจุดตัดของ Gride Line จะปรากฎ 
Node  เสา  ให้ด าเนิการจนครบตามที่ต้องการ แล้วกลับสู่เมนู Drafting โดย
การคลิกเม้าขวา 

 

 

 

 

 

 

 

 

รูปที่  4.16  เลือก Node  Column 

 

 

 

 

 

 

 

รูปที่  4.17  กดปุ่ม OK เลือกต าแหน่งที่ต้องการ  
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รูปที่  4.18  เลือกที่ต าแหน่งจุดตัด Gride line  

 

  

 

 

 

 

 

 

รูปที่  4.19  Node  เสาจากการเลือกที่ต าแหน่งจุดตัด Gride Line 
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รูปที่  4.20 คลิกเม้าส์ที่ปุ่มขวา กลับสู่ เมนู Drafting 

4.2.3  สร้างเส้นร่าง (Guide Line)  เป็นเส้นส าคัญจ าเป็นต้องมีขึ้นเพื่อช่วยในการร่างแบบ 
และก าหนดต าแหน่งของเสา, คาน, พื้น และผนัง ในทุกขั้นตอนของ A2D RC หาก
ถูกลบไปจะท าให้ป้อนข้อมูลน าเข้าโปแกรม ด้วยวิธีกราฟิกไม่ถูกต้อง ส่งผลต่อการ
วิเคราะห์ออกแบบและเขียนแบบโครงสร้าง ค.ส.ล. พื้น-คาน ผิดพลาดได้  เส้นร่าง
แบบจะถูกลบได้ก็ต่อเมื่อไม่ได้ใช้งานในส่วนขององค์อาคารนั้นๆ หรือเมื่อเสร็จสิ้น
ขั้นตอนการร่างแบบ   เข้าสู่ขั้นตอนการวิเคราะห์  ออกแบบและเขียนแบบที่เมนูหลัก 
Drafting กดปุ่ม Automat ปรากฎสร้างเส้นร่างแบบ อัตโนมัติ  

 
 
 
 

 

 

 

 

รูปที่  4 .21 กดปุ่ม Automat สร้างเส้นร่าง อัตโนมัติ 



26 
 

กรณีต้องการสร้างเส้นร่างด้วยตนเองในแนวคาน, พื้นหรือผนัง นอกเหนือจากที่
โปรแกรมได้สร้างขึ้นให้อัตโนมัติ  ท าได้โดยการเลือกที่ปุ่มค าสั่ง Manual แล้วท าการเขียนเส้นร่าง
ได้ตามที่ต้องการ หากต้องการลบเส้นร่างแบบ  ก็สามารถท าได้โดยค าสั่งพื้นฐาน AutoCAD ** 
A2D RC เวอร์ชัน 1.26 นี้ ยังไม่ถูกพัฒนาให้เขียนเส้นร่างแบบนอกเหนือระนาบของแกน X-Y ได้ 

Layer ต่างๆ ไม่จ าเป็นที่ผู้ใช้งานต้องสร้างเอง A2D RC จะสร้างขึ้นให้อัตโนมัติ การ 
On-Off ท าได้ด้วยค าสั่งบนทูลบาร์ในแต่ละฟอร์ม และเมนูทูลบาร์หลัก, ย่อย 

 

 

รูปที่  4 .22 ค าสั่งเปิด-ปิด เลเยอร์ AutoCAD 

4.2.4  ก าหนดชั้นของอาคาร  เพื่อน าเข้าข้อมูลเสา , คาน ,พื้นและผนัง  ที่เมนูหลัก Drafting 
กดที่ List Box   ปรากฏชั้นของอาคารทุกชั้นให้เลือกชั้นที่ 1 หรือชั้นอ่ืน ของอาคาร
เพื่อเร่ิมต้นการท างานเป็นชั้นแรก               

 

 

 

 
 
 

 
 
 

 
     

            รูปที่ 4.23  กดที่ List Box                                    รูปที่  4.24  ชั้นของอาคารทุกชั้น 
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                 รูปที่ 4.25  เลือกชั้นที่ 1                                              รูปที่ 4.26 ปรากฏชั้นที่ 1  
 

4.2.5  การป้อนข้อมูล Column เป็นขั้นตอนการน าเข้าข้อมูลขนาดของเสา ที่ได้จากการ
อ่านแบบ หรือภาพร่างแบบ โดยกดปุ่ม Draw Column จะปรากฎพื้นที่ท างานชั้นที่ 1 
(ที่ได้เลือกชั้นท างานเอาไว้แล้วในขั้นตอนก าหนดชั้นของอาคาร) เลือกปุ่ม Column 
ป้อนข้อมูลขนาดของเสา แล้วกดปุ่ม Section จะปรากฎ หน้าตัดเสาที่ได้ก าหนดไว้ ณ 
ต าแหน่ง Node เสา 

 
 

 
 
 
 
 
 
 
 
 

                  รูปที่  4.27  กดปุ่ม Draw Column 
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รูปที่  4.28  เลือกปุ่ม Column 

 

รูปที่  4.29   ป้อนข้อมูลขนาดของเสา  
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รูปที่  4.30   กดปุ่ม Section ปรากฎหน้าตัดเสาบนแบบร่าง 

4.2.6  การป้อนข้อมูล Beam เป็นขั้นตอนการน าเข้าข้อมูลคานทั้งชั้นของอาคารโดยท าตาม
ขั้นตอนดังน้ี 
4.2.6.1 ป้อนข้อมูล Beam อัตโนมัติ  เป็นขั้นตอนการน าเข้า ข้อมูลคาน ที่ได้จากการ

อ่านแบบ โดยท าการก าหนดหน้าตัด Trial แล้วกดปุ่ม Draw โปรแกรมจะ
สร้างคานตามเส้นร่างให้อัตโนมัติ ทั้งชั้น 

 
 

 
 

 
 
 
 
 
 
 
 

           
รูปที่  4.31 เมนู Drafting กดปุ่ม Draw Beam 
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รูปที่  4.32 กดปุ่ม Draw ปรากฎแนวคานบนแบบร่าง 

 
4.2.6.2  ป้อนและลบข้อมูล Beam ด้วยตัวเอง 

     เป็นขั้นตอนการน าเข้าและลบข้อมูลคานด้วยตัวเอง  
 

 

 

 

 

 

 
                      รูปที่  4.33 กดปุ่ม Draw Beam  
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รูปที่  4.34 กดปุ่ม Select draw 
 
 
 
 

 
 
 
 

 
 

รูปที่  4.35 เลือกเส้นร่าง (Guild Line)   
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รูปที่  4.36 คานถูกสร้างขึ้นตามเส้นร่างที่ถูกเลือก 

 

 

รูปที่  4.37 เลือกคานที่ต้องการลบ 

 

 

 

 

 
 

รูปที่  4.38  กดปุ่มสั่ง Delete   
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4.2.7  การป้อนข้อมูล Slab เป็นขั้นตอนการน าเข้าข้อมูลพื้นที่ได้จากการอ่านแบบโดยท า
การก าหนดประเภทของพื้น แล้วเลือกลงไปในขอบเขตรูปสี่เหลี่ยมของเส้นร่าง 
โปรแกรมจะสร้างพื้นให้อัตโนมัติ ในต าแหน่งที่เลือก กรณีที่เป็นพื้นวางบนดินหรือ
ต าแหน่งที่โปรแกรมไม่พบเส้นร่างครบขอบเขตรูปสี่เหลี่ยมปิดสี่ด้าน โปรแกรมจะ
สร้างพื้นขนาด 1 ตารางเมตร ให้ท าการขยายขอบเขตพื้นให้ชนคานหรือแนวขอบอื่น
ให้ครบทั้งสี่ด้าน 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่  4.39 กดปุ่ม Slab ที่เมนู Draw slab เลือกประเภทพื้น  เลือกวางต าแหน่งของพื้นในแบบ  

4.2.8  การป้อนข้อมูล Wall  เป็นขั้นตอนการน าเข้าข้อมูลผนังที่ได้จากการอ่านแบบโดยท า
การก าหนดประเภทและความสูงของผนัง  แล้วกด Draw โปรแกรมจะสร้างผนังให้
อัตโนมัติและสร้างผนังได้เองด้วย Select Draw  เลือกที่เส้นร่าง  ก็จะสร้างผนังได้
เช่นกัน 
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รูปที่  4.40   กดปุ่ม Draw สร้างผนัง 

 

 

 

 

 

 

 

 

รูปที่  4.41  เลือกเส้นร่างที่ต้องการเขียนผนัง แล้วกด Draw Select 
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รูปที่  4.42  เลือกชนิดของวัสดุผนังชั้นที่ 1 

 

 

 

 

 

 

 
รูปที่  4.43  กดปุ่ม Draw ปรากฎผนังตามเส้นร่างทั้งชั้น 
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4.2.9 การคัดลอกข้อมูลเสา, คาน, พื้น และผนัง  
เป็นขั้นตอนเพื่อลดระยะเวลาการท างาน ที่ไม่ต้องท างานซ้ าๆในทุกชั้นของอาคาร 

โดยโปรแกรมสามารถคัดลอกข้อมูลกันระหว่างชั้นได้ มีขั้นตอนดังน้ี 
4.2.9.1 คัดลอกข้อมูลไปชั้น  Footing และไปชั้นอื่น 
 
 
 
 
 
 
 
 
 
 
 

                  
 

       รูปที่  4.44  เลือกชั้นที่ต้องการคัดลอก        รูปที่ 4.45  คัดลอกข้อมูลไปชั้น  Footing 

4.2.9.2 คัดลอกไปยัง ชั้น Roof 

 

 

 

 

 

 

รูปที่  4.46 ที่ชั้นที่ 1 กดปุ่ม Copy to Floor ส าเนาไปยัง ชั้น Roof  



37 
 

4.2.10 การป้อนข้อมูล Roof  เป็นขั้นตอนการน าเข้าข้อมูลชั้นหลังคา  ดังนี ้
 

 

 

 

 

 

 

 
 

รูปที่  4.47  กดปุ่ม Roof  เพื่อน าเข้าข้อมูลหลังคา 

4.2.10.1 ป้อนข้อมูล Evaes Line คือการน าเข้าข้อมูลชายคา ของหลังคาทั่วไป 
 
 
 
 
 
 
 
 
 
 

 

รูปที่  4.48  กดปุ่ม Eaves line  ป้อนข้อมูลชายคารอบอาคาร  
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รูปที่  4.49  เขียนเส้นชายคาให้ครบทุกด้าน 

4.2.10.2 ป้อนข้อมูล Flashing คือการน าเข้าข้อมูลชายคาหลังคาแบบหมาแหงน 
 

 

 

 

 

 

 

 

                   รูปที่ 4.50 ป้อนข้อมูล Flashing Line  
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4.2.10.3 ป้อนข้อมูล Ride Line คือการน าเข้าข้อมูลอกไก่ ของหลังคาทั่วไป 
 
 

 
 

 

 

 

 

 
รูปที่ 4.51 ป้อนข้อมูล Ride Line  

 

4.2.10.4 ป้อนข้อมูล King Post คือการน าเข้าข้อมูล โดยก าหนดต าแหน่งดั้งเพื่อใช้
ถ่ายน้ าหนักจากโครงสร้างหลังคา กระท าแบบ Point load ไปยังคานรับ
โครงหลังคา (Roof Beam) 

  
 
 
 
 
 
 
 

 
 
 

 
รูปที่ 4.52 ป้อนข้อมูลดั้งกดปุ่ม King Post แล้วเลือกวางในแบบ 
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4.2.10.5 ป้อนข้อมูล Hip Rafter คือการน าเข้าข้อมูลตะเฆ่สัน ของหลังคาทรง
ปั้นหยา 

 
 
 
 
 
 
 
 

 
 
 

 

รูปที่ 4.53 ป้อนข้อมูล Hip Rafter (เส้นสีเขียว) 
 

4.2.10.6 ป้อนข้อมูล Vallay Rafter คือการน าเข้าข้อมูลตะเฆ่ราง ของหลังคาปั้นหยา 
 
 
 
 
 
 

 
 
 
 

 
รูปที่ 4.54 ป้อนข้อมูล Vallay Rafter (เส้นสีน้ าเงิน) 
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4.2.10.7  ป้อนข้อมูล Distance Between Rafter คือระยะห่างระหว่างจันทัน  
 
 
 
 
 
 
 
 
 
 

 
รูปที่ 4.55 ป้อนข้อมูล ระยะห่างระหว่างจันทัน  
 

4.2.10.8 ป้อนข้อมูล Rafter  คือการน าเข้าข้อมูลจันทัน ของหลังคาทั่วไป 
 
 
 
 
 
 
 
 
 
 
 

 
รูปที่ 4.56 กดที่ปุ่ม Rafter ป้อนข้อมูลจันทันโดยอัตโนมัติ  
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4.2.10.9 ป้อนข้อมูล Steel Beam คือการน าเข้าข้อมูลอะเส ของหลังคาทั่วไป A2D 
RC สามารถวิเคราะห์ ออกแบบ ได้เพียงโครงสร้างคาน ค.ส.ล. ยังไม่ได้มี
การรองรับการออกแบบโครงสร้างเหล็กรูปพรรณ 

4.2.10.10 ป้อนข้อมูล Roof Material คือการก าหนดวัสดุมุงหลังคา ทิศทางการมุง 
และองศา  เพื่อใช้ในการถ่ายน้ าหนักบรรทุกลงสู่โครงหลังคาต่อไป 

 
 

 
 
 
 
 
 
 

 
รูปที่  4.57  เลือกปุ่ม Roof  Material น าเข้าข้อมูลชนิดวัสดุและทิศทางการมุง 

 

 

 

 

 

 

รูปที่  4.58  เลือกวัสดุมุง 
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รูปที่  4.59   เลือกทิศทางการมุง 

 

 

 

 

รูปที่  4 .60  กดปุ่ม Return โปรแกรมก็จ าค านวณ Area ของชั้น Roof 
เพื่อใช้ในการออกแบบ Roof Beam (RB) 
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บทที่  5   
การวิเคราะห์  ออกแบบและเขียนแบบพื้น-คาน ค.ส.ล. 

 
จากบทที่ 4 เมื่อได้น าเข้าข้อมูล  จากการเขียนแบบแปลนอาคารแล้วเสร็จ  ในบทนี้จะ

อธิบายขั้นตอนที่ส าคัญในส่วนของการวิเคราะห์  ออกแบบและเขียนแบบโครงสร้าง  โดยมีขั้นตอน
ดังต่อไปนี้ 

 

5.1  การก าหนดคุณสมบัติของวัสดุ 
 5.1.1  ก าลังอัดประลัยของคอนกรีตรูปทรงกระบอกที่อายุ 28 วัน 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
        
 

 รูปที่ 5.1  เมนูหลัก  เลือกปุ่มค าสั่ง Criteria             รูปที่ 5.2  เลือกก าลังอัดประลัยของคอนกรีต 
   รูปทรงกระบอกที่อายุ  28  วัน 
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5.1.2   ชั้นคุณสมบัติและแรงดึงประลัยของเหล็กเสริมคอนกรีต   เลือกได้ 2 ชนิดคือ  
           RB  เป็นเหล็กเสริมที่ใช้ในโครงสร้างพื้นและเหล็กปลอกคานมีชั้นคุณภาพคือ SR 

24 มีขนาด 6, 9 และ 12 มิลลิเมตร 
 SD  เป็นเหล็กเสริมที่ใช้ในโครงสร้างคาน มีชั้นคุณภาพ คือ SD 30, 40 มีขนาด 

ตั้งแต่ 12  มิลลิเมตร ขึ้นไป 
5.1.3   ระยะหุ้มของเหล็กเสริมในคอนกรีต  เลือกที่ปุ่มค าสั่ง Conctrte covering เพื่อก าหนด 

ระยะเหล็กเสริมหุ้มด้วยคอนกรีตใน Excel 
 
 

 
 

 

 

รูปที่ 5.3 ระยะเหล็กเสริมหุ้มด้วยคอนกรีต 
 

5.1.4  การจัดเก็บข้อมูล โดยเลือกที่ปุ่มค าสั่ง Input Data เพื่อให้ Excel เก็บข้อมูลที่ใช้ใน 
การวิเคราะห์ ออกแบบและเขียนแบบโครงสร้างพื้น-คาน ค.ส.ล. กด Close-Save 
กลับสู่ AutoCAD 

 
 
 
 
 
 
 
 
 
 
 

รูปที่ 5.4  Excel ท าการเก็บข้อมูลจาก AutoCAD 
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5.2  การวิเคราะห์ ออกแบบและเขียนแบบพื้น ค.ส.ล. 
       เป็นขั้นตอนที่ส าคัญในการน าเอาข้อมูลที่ได้จากการร่างแบบ และข้อมูลคุณสมบัติของ 
วัสดุ  ที่ได้ด าเนินการและจัดเก็บข้อมูลใน Microsoft Excel ท าการวิเคราะห์ ออกแบบและเขียนแบบ 
พื้น ค.ส.ล. มีขั้นตอนดังน้ี 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
รูปที่ 5.5  ผังขั้นตอนการวิเคราะห์  การออกแบบและเขียนแบบโครงสร้างพื้น ค.ส.ล. 
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5.2.1 การแก้ไขน้ าหนักบรรทุก  
ที่ เมนู  Load on Slab เลือก Add & Edit load เพื่อท าการ เพิ่มเติม แก้ไข น้ าหนัก

บรรทุกจร (LL) และ Super imposed Dead Load(SDL) เลือกพื้นในแบบต้องการแก้ไขจนครบแล้ว  
Click mouse  ขวา 

 
 

 

 

 

 

รูปที่  5.6   Add & Edit load 

 

รูปที่  5.7  กด  Select  fioor  เลือกพื้นที่ต้องการ 
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5.2.2  การวิเคราะห์ ออกแบบและเขียนแบบพื้น ค.ส.ล. 
เมื่อได้ก าหนดค่าพิกัดและพารามิเตอร์ต่างๆ แล้วเสร็จ  ขั้นตอนต่อจากนี้ก็คือการ 

วิเคราะห์หาแรงภายของพื้น(ใช้วิธีที่ 2 กรณี ที่ 5 ตาม วสท. 9102) เพื่อค านวณหาความหนาของแผ่น
พื้นและปริมาณของเหล็ก 
 
 
 

 
 
 
 
 
 

 
5.2.2.1 ตารางค านวณ 
           ที่เมนู  Select  for  design slab  ให้เลือกปุ่มค าสั่ง  RC Slab >  RC  Design of 

Slab   
 
 
 
 
 
 
 
 
 
 

รูปที่  5.8  แสดงผลการค านวณวิเคราะห์   ออกแบบพื้นทางเดียว , พื้นสองทาง 
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5.2.2.2  การเขียนแบบ   ขยายพื้น ค.ส.ล. ที่ เมนู  Design Slab ให้ เลือกปุ่มค าสั่ ง 
Drawing Slab 

 

 
 

รูปที่  5.9   แบบขยายพื้นและกรอบพร้อมพิมพ์ 

 
5.2.2.3   เปลี่ยนชื่อพื้นในแบบแปลน เมื่อได้หมายเลยก ากับตามที่ระบุในแบบขยาย

พื้นแล้ว  โปรแกรมก็จะสามารถเปลี่ยนชื่อในแบบแปลนได้โดยการเลือก
ค าสั่ง Rename on Plan 

5.2.2.4  แก้ไขรายการค านวณพื้น ท าได้โดยไปที่เมนู Design Slab เลือกค าสั่ง Edit 
calculation sheet 

5.2.2.5  แก้ไขหน้าตัดพื้น และรายละเอียด   การเสริมเหล็กในแบบกรณีที่ต้องการ
แก้ไข รายละเอียดของแบบขยายโครงสร้างพื้น ก็สามารถท าได้โดยไปที่เมนู 
Design Slab เลือกค าสั่ง Edit floor section drawing แล้วเลือกแบบหน้าตัด
พื้น ที่ต้องการแก้ไขชื่อ , ความหนา, ระยะห่างและปริมาณ เหล็กเสริม 
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รูปที่ 5.10  เลือก  Rename  on  Plan  ตั้งชื่อพื้นในแปลนอัตโนมัติ 
 

 
 

รูปที่ 5.11  Edit  calculation  แล้วเลือกตารางที่ต้องการแก้ไข 
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รูปที่ 5.12  Edit  fioor  section  drawing แก้ไขแบบขยายโครงสร้างพื้น 
 
5.3  การถ่ายน าหนักบรรทุกจากหลังคา 
             กรณีที่อาคารมีหลังคารูปทรงต่างๆ  และมีวัสดุมุงหลังคาที่แตกต่างกัน  ก่อนจะมีการ
ออกแบบคาน ค.ส.ล. รับน ้าหนักบรรทุกทางโครงหลังคา (จันทันพราง) จ าเป็นจะต้องมีการค านวณ
เพื่อ คิดถ่ายน้ าหนักบรรทุกเสียก่อน A2S RC มีฟังก์ชั่นที่ช่วยงานดังกล่าวโดยท าการเลือกค าสั่ง 
Roof เพื่อเข้าสู่เมนู Design roof กดปุ่ม Listbox เลือกชื่อหลังคาที่เคยถูกตั้งเอาไว้แล้วในขั้นตอนการ
ร่างแบบชั้น Roof กดปุ่ม Load Transform 
 
 
 
 
 
 
 
 
 

 
 

รูปที่ 5.13  ขั้นตอนการถ่ายน้ าหนักบรรทุกจากหลังคา 
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5.4  การวิเคราะห์ ออกแบบและเขียนแบบโครงสร้างคาน ค.ส.ล. 
เป็นขั้นตอนที่ส าคัญในการน าเอาข้อมูลที่ได้จากการร่างแบบ และข้อมูลคุณสมบัติของ 

วัสดุที่ได้ด าเนินการและจัดเก็บข้อมูลใน Microsoft Excel ท าการวิเคราะห์ ออกแบบและเขียนแบบ 
คาน ค.ส.ล. มีขั้นตอนดังน้ี 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 5.14  ผังขั้นตอนการวิเคราะห์ ออกแบบและเขียนแบบโครงสร้างคาน ค.ส.ล. 
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5.4.1  ก าหนดชั้นของอาคาร  เป็นขั้นตอนที่ก าหนดให้โปรแกรมท าการวิเคราะห์ออกแบบ
และเขียนแบบคาน ค.ส.ล. ชั้น Roof 

5.4.2  การแก้ไขระดับ,  ชื่อของคาน  เลือก Edit level name จะปรากฏฟอร์ม Ele. and Scale 
กดปุ่ม Input เพื่อป้อนตัวเลขหรือค าที่ต้องการ  จากนั้นก็เลือกในแบบร่างให้ตรงกับ
แบบทางสถาปัตยกรรม 

 
 

 

 

 

 

 

รูปที่ 5.15 เลือกชั้นงาน             รูปที่ 5.16  Edit level name         รูปที่ 5.17 แก้ไขชื่อหรือค่าระดับ 

5.4.3  การถ่ายน้ าหนักบรรทุกแบบแผ่กระจาย  เลือก  Load  on  Beam   
5.4.4  การก าหนดคานแบบยื่น เลือก  Cantilever Beam 
5.4.5  การถ่ายน้ าหนักบรรทุกแบบกระท าเป็นจุด  เลือก  Point  Load   

 
 
 
 
 
 
 
 
รูปที่ 5.18  ถ่ายน้ าหนักลงบนคาน        รูปที่ 5.19  เลือกจากคานยื่น     รูปที่ 5.20 ถ่ายน้ าหนักลงคาน            
                  แบบแผ่กระจาย                                    จากแบบ                                  กระท าเป็นจุด 
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5.4.6  การเลือกแบบคานต่อเนื่อง เลือก  Continuouse  Beam 
5.4.7  การเพิ่มเติมน้ าหนักบรรทุก  เลือก  Add  Load 

 

 

 

 

 

 

 

 
 

รูปที่ 5.21  เลือกคานแบบ         รูปที่ 5.22  เพิ่มน้ าหนัก      รูปที่ 5.23 ป้อนน้ าหนัก    
                  ต่อเนื่อง                                         บรรทุก                                          บรรทุก 
 
 5.4.8  การ  Trial  Section  คาน 
 

 

 

 

 

 

                        
        รูปที่ 5.24  Trial  Section                            รูปที่ 5.25  การก าหนดหน้าตัดคาน 
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5.4.9  การแก้ไขหน้าตัดคาน 
 

 

 

 

 

 

 

 

 รูปที่ 5.26  แก้ไขหน้าตัดคาน                                   รูปที่ 5.27  ก าหนดหน้าตัดที่ต้องการแก้ไข 

5.4.10  การวิเคราะห์ออกแบบโครงสร้าง 

 

 

 

 

 

 

 

 
 

 รูปที่ 5.28  วิเคราะห์และออกแบบ                             รูปที่ 5.29  ข้อความเตือนให้ตรวจสอบ 
                   คาน ค.ส.ล.                                                                ความถูกต้อง 
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5.4.11  รายการค านวณโครงสร้างและออกแบบคาน ค.ส.ล. 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่  5.30  แสดงตารางค านวณวิเคราะห์โครงสร้างด้วยวิธีกระจายโมเมนต์ 
 
5.4.12  แสดงผลของแรงลัพธ์  ปริมาณเหล็กเสริมและหน้าตัดคาน 
 

 

 

 

 

 

 

 

 

รูปที่  5.31  แสดงตารางค านวณวิเคราะห์โครงสร้างและออกแบบคาน ค.ส.ล. 
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รูปที่  5.32  ภาพแรงน ้าหนักบรรทุก  ภาพแรงเฉือน ภาพโมเมนต์ดัด จุดและระยะดัดกลับ 
                           ( FBD ,SFD, BMD , Inflection point) 
 
5.5   การเขียนแบบโครงสร้างคาน ค.ส.ล.  และแบบแสดงรายละเอียด  
 เป็นขั้นตอนสุดท้ายหลังจากที่ได้ท าการวิเคราะห์  ออกแบบโครงสร้างคาน ค.ส.ล.  เป็นที่
เรียบร้อยแล้ว จากนี้คือการจัดท าแบบและรายละเอียดขยาย  มีขั้นตอนดังน้ี 

5.5.1  การเขียนแบบคานแสดง  1  หน้าตัด 
          5.5.1.1  ตรวจสอบปริมาณเหล็กเสริมในคาน ค.ส.ล. บนคานช่วงเดียว 

 
 

 

 

 

 

 

 

รูปที่ 5.33  Drawing &  Detial               รูปที่ 5.34  เลือก  Check  steel  bar 
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                                               รูปที่ 5.35  ตรวจสอบพบว่าถูกต้อง 
 

5.5.1.2  จัดกลุ่มคาน 
 
 
 
 
 
 
 

 
 
 

รูปที่ 5.36  จัดกลุ่มคานชั้นหลังคา 
 
 
 
 
 
 
 
 
 
 

รูปที่ 5.37  Send  to  Excel ,  ตั้งชื่อ  ,  ลบชื่อซ้ า , Save-Close 
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 รูปที่ 5.38 Draw  Beam                    รูปที่ 5.39  หน้าตัดคานและรายละเอียดการเสริมเหล็ก                                                             
 

5.5.1.3  เปลี่ยนชื่อคานในแบบแปลน 
 

 
 

รูปที่ 5.40  ชื่อของคานในแบบแปลนจะเปลี่ยนตามการจัดกลุ่มคาน 
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5.5.2  การเขียนแบบคาน  แสดง 3 หน้าตัด 
         5.5.2.1  ตรวจสอบปริมาณเหล็กเสริมในคาน ค.ส.ล. บนคานต่อเนื่อง 

 
 

 

 

 

 

 

 
 
 
 

         รูปที่ 5.41  Drawing &  Detial                                              รูปที่ 5.42  เลือก  Check  steel  bar 
 
 
 
 
 
 
 

รูปที่ 5.43  ตรวจสอบพบว่าถูกต้อง 
 

5.5.2.2 แก้ไขตารางค านวณและออกแบบคาน 
    กรณีตรวจสอบแล้วไม่ผ่านให้ท าการเปลี่ยนหน้าตัดคานให้ลึกมากขึ้น  หรือ

เปลี่ยนขนาดเหล็กเสริมให้ใหญ่ตลอดทั้งช่วงคานในกริดลายนั้น  เมื่อเปลี่ยนขนาดแล้วให้ใช้เม้าส์
ลากเลือกมุมทุกตารางทั้งบรรทัดที่ท าการปรับแก้ 
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5.5.2.3  แก้ไขขนาดหน้าตัดคาน  และปริมาณเหล็กเสริมในคาน ค.ส.ล.บนคาน
ต่อเน่ือง 

 
 
 
 
 
 
 
 
 

      
 

          รูปที่ 5.43   ปรับขนาดคานให้ลึกขึ้น                                รูปที่ 5.44  ปรับขนาดเหล็กเส้น 
 

5.5.2.4 จัดกลุ่มคาน 
 

 
 
 
 
 
 
 
 
 
 
 

                รูปที่ 5.45   จัดกลุ่มคาน                                                         รูปที่ 5.46   Send to  Excel 
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รูปที่ 5.47  ตั้งชื่อคาน ,ลบชื่อซ้ า, Save-Close 
 

 
 

 
 
 
 
 
 
 

รูปที่ 5.48  Draw  beam section  ชั้น  Roof 
 
 
 
 
 
 
 

รูปที่ 5.49  แบบขยายรายละเอียดคาน RB 
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รูปที่ 5.50   Draw  beam section  ชั้นทั่วไป 
 
 
 
 
 
 
 

รูปที่ 5.51 แบบขยายรายละเอียดคาน B 
 

5.5.2.5  เปลี่ยนชื่อคานในแบบแปลน 
 
 
 
 
 
 
 
 
 
 

รูปที่ 5.52  ชื่อของคานในแบบแปลนจะเปลี่ยนตามการจัดกลุ่มคาน 
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5.5.3  การเขียนภาพตัดทางยางของคาน  ค.ส.ล. แบบต่อเนื่อง 
 
 
 
 

 

                                                       รูปที่ 5.53  Draw  profile 
 

 
 
 
 
 

 
 
 

รูปที่ 5.54   Profile and section 
 

5.5.4  การแก้ไขหน้าตัดคานในแบบ 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 5.55  Select  Beams  for  Change 
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5.5.5 การสร้างแบบข้อก าหนดท่ัวไปทางวิศวกรรมโครงสร้าง   เป็นการด าเนินการจัดท า
แบบเพื่อน าไปใช้งาน  มีขั้นตอนดังต่อไปนี้ 
5.5.5.1 ท่ีเมนู  A2D RC  เลือก  Structure ปรากฏเมนยู่อย  Structure Drawing 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่ 5.56 ผังขั้นตอนการสร้างแบบข้อก าหนดทั่วไปทางวิศวกรรม 
 

5.5.5.2 ท่ี เม นู ย่ อ ย  Structural Drawing เลื อ ก ท่ี  Tripical ข อ ง  Drawing & 
Dimension แล้วเลือกพื้นที่ว่างที่ต้องการ จะวางแบบข้อก าหนดทั่วไปทาง
วิศวกรรม กดเลือก จะปรากฏแบบพร้อมกรอบกระดาษแบบที่มีรายละเอียด
ครบ 
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รูปที่ 5.57  แบบข้อก าหนดทั่วไปงานวิศวกรรมโครงสร้าง 
 

5.5.6 การสร้างแบบแปลนพื้น-คาน ค.ส.ล. เป็นการด าเนินการจัดท าแบบ  เพื่อน าไปใช้งาน 
มีขั้นตอนดังต่อไปนี้ 
5.5.6.1 ท่ีเมนู A2D RC เลอืก Structure Drawing 
5.5.6.2 ท่ี เมนูย่อย Structural Drawing เลือก ท่ี  List box ของ Paper view แล้ว

เลือก ชั้นโครงสร้างของอาคารที่ต้องการ กดเลือก View port จะปรากฏแบบ
พร้อมกรอบกระดาษแบบ (Titel Box) ให้ท าการจัดวางให้เหมาะสมใน
หน้ากระดาษ กดปม Regenerate  เพื่อปิด  View  port 
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         รูปที่ 5.58  เลือกชั้นที่ต้องการ                                          รูปที่ 5.59   เลือก  View  port 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่ 5.60  View  port  พร้อมกรอบกระดาษแบบ 
 

5.5.7 การสร้างแบบขยายโครงสร้างพื้น-คาน ค.ส.ล. เป็นการด าเนินการจัดท าแบบ เพื่อ
น าไปใช้งาน โดยเลือกที่ Tab ที่มีชื่อว่า Structure ของ AutoCAD บนพื้นที่ท างานจะ
ปรากฏแบบ ขยายพื้นและหน้าตัดคาน ค.ส.ล. ถูกสร้างไว้โดยอัตโนมัติ  ให้ท าการ
ตรวจสอบความถูกต้อง ครบถ้วนสมบูรณ์แล้ว  สามารถพิมพ์แบบน าไปใช้งานได้ 

 
 
 
 

รูปที่ 5.61  Tab ที่มีชื่อว่า Structure  
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รูปที่ 5.62  แบบแปลนโครงสร้างชั้น 1  และแบบแปลนคานรับโครงหลังคา 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 5.63  แบบขยายพื้น ค.ส.ล. 
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รูปที่ 5.64   แบบขยายรูปตัดคาน ค.ส.ล. 
 

5.6  การสร้างรายการค านวณโครงสร้างพื้น-คาน ค.ส.ล. 
เป็นการด าเนินการจัดท ารายการค านวณเพื่อน าไปใช้ตรวจสอบความถูกต้องในการ

วิเคราะห์ ออกแบบโครงสร้าง หรือใช้ประกอบการยื่นขออนุญาตก่อสร้างอาคารต่อหน่วยงาน
ท้องถิ่น  โดยเลือกที่  Tab ที่มีชื่อว่า Design ของ AutoCAD บนพื้นที่ท างานจะปรากฏรายการ
ค านวณของพื้นและคาน ค.ส.ล. ถูกสร้างไว้โดยอัตโนมัติ  ให้ท าการตรวจสอบความถูกต้อง 
ครบถ้วนสมบูรณ์แล้วสามารถพิมพ์ออกมา น าไปใช้งานได้ 

 
 
 
 
 

รูปที่  5.65  Tab  ชื่อว่า  Disign 
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บทที่  6   
สรุปผลที่ได้จากการใช้ A2D RC 

 

เมื่อได้น ำเข้ำข้อมูลแบบมำตรฐำนบ้ำนเพื่อประชำชน พ.ศ. 2559 ของกรมโยธำธิกำรและผัง 
เมือง  กระทรวงมหำดไทย  จ ำนวน 2 แบบ ผ่ำนกระบวนกำรท ำงำนบน A2D RC ผลลัพธ์ที่ได้คือ 
สำมำรถด ำเนินกำรวิเครำะห์ ออกแบบและเขียนแบบโครงสร้ำงพื้นคำนคอนกรีตเสริมเหล็ก ด้วยวิธี 
หน่วยแรงใช้งำน ได้อย่ำงถูกต้องรวดเร็วเมื่อเปรียบเทียบกับกำรค ำนวณด้วยมือ 
 
6.1  แบบข้อก าหนดท่ัวไปทางวิศวกรรมโครงสร้าง 
 

 
 

รูปที่  6.1  แบบข้อก ำหนดทั่วไปงำนวิศวกรรมโครงสร้ำง 
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6.2  แบบแปลน-ขยายโครงสร้างพื้นและคาน ค.ส.ล. 
 

 
 

 

 

 

 

 

 

 

รูปที่  6.2  แบบแปลนโครงสร้ำงชั้น 1  และแบบแปลนคำนรับโครงหลังคำ 
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รูปที่  6.3  แบบขยำยโครงสร้ำงพื้น ค.ส.ล. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่  6.4  แบบขยำยรูปตัดขวำงโครงสร้ำงคำน ค.ส.ล. 
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6.3  รายการค านวณ  การวิเคราะห์ ออกแบบและเขียนแบบพื้น-คาน ค.ส.ล. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่  6.5  หน้ำปกรำยกำรค ำนวณ 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่  6.6  ข้อก ำหนดทำงวิศวกรรมโครงสร้ำง  เพื่อใช้ในกำรออกแบบ 
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รูปที่  6.7  รำยกำรค ำนวณวิเครำะห์  ออกแบบพื้นทำงเดียว ค.ส.ล. 

 
 

รูปที่  6.8  รำยกำรค ำนวณวิเครำะห์  ออกแบบพื้นสองทำง ค.ส.ล. 
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รูปที่  6.9  รำยกำรค ำนวณวิเครำะห์  ออกแบบคำน ค.ส.ล.ช่วงเดียว 
 

 
 

รูปที่  6.10  รำยกำรค ำนวณวิเครำะห์  ออกแบบคำน ค.ส.ล.ช่วงต่อเน่ือง 1 
 



76 
 

 
 

รูปที่  6.11  รำยกำรค ำนวณวิเครำะห์  ออกแบบคำน ค.ส.ล.ช่วงต่อเน่ือง 2 
 

 
 

รูปที่  6.12  รำยกำรค ำนวณวิเครำะห์  ออกแบบคำน ค.ส.ล.ช่วงต่อเน่ือง 3 
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รูปที่  6.13  รำยกำรค ำนวณวิเครำะห์  ออกแบบคำน ค.ส.ล.ช่วงต่อเน่ือง 4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่  6.14  รำยกำรค ำนวณวิเครำะห์  ออกแบบคำน ค.ส.ล.ช่วงต่อเน่ือง 5 



161 

 

 

 

 

 

 

 

 

 

ภาคผนวก ข 
แบบก่อสร้างเพื่อใช้ในการศึกษาของกรมโยธาธิการและผังเมือง 

กระทรวงมหาดไทย พ.ศ. 2550 
 

1. แบบบ้านครอบครัวไทยร่วมสมัย 2 พื้นที่ใช้สอย 120 ตารางเมตร 
2. แบบบ้านครอบครัไทยร่วมสมัย 6 พื้นที่ใช้สอย 70 ตารางเมตร 
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ประวัติผู้เขียน 

 นายอดิศร  ไชยโคตร  เกิดวันที่  26  สิงหาคม  2518  ที่อ าเภอเมืองวารินช าราบ  จังหวัด
อุบลราชธานี  สถานที่อยู่ปัจจุบัน  499  หมู่ที่  4 ต าบลสูงเนิน  อ าเภอสูงเนิน  จังหวัดนครราชสีมา  
ด้านการศึกษาส าเร็จการศึกษาระดับประกาศนียบัตรวิชาชีพชั้นสูง  สาขาช่างโยธา จากสถาบัน
เทคโนโลยีราชมงคล  วิทยาเขตภาคตะวันออกเฉียงเหนือ  และระดับปริญญาตรี  สาขาวิศวกรรม
โยธา  จากมหาวิทยาลัยเทคโนโลยีราชมงคล  อีสาน  จังหวัดนครราชสีมา   
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